This manual describes the installation procedure for the Celeritas System. Please review the manual prior to unpacking and installing the system. The Celeritas System is designed to collect joystick movements and button presses from participants in an MRI or MEG environment via any computer system equipped with a Windows XP or later operating system. Celeritas also operates as a standalone HID (Human Interface Device) on any computer system that supports Full Speed USB. Proper performance of this system is guaranteed only while the system is used in accordance to the enclosed instructions and safety guidelines.

**NOTICE:**
TRANSPORT AND STORE THIS PRODUCT UNDER THE FOLLOWING ENVIRONMENTAL CONDITIONS ONLY, FOR A PERIOD NOT EXCEEDING 4 WEEKS:

- AMBIENT TEMPERATURE OF -40°C to +60°C
- RELATIVE HUMIDITY OF 10% TO 100% (Non-Condensing)
- ATMOSPHERIC PRESSURE OF 765 hPa TO 1011 hPa

The Celeritas Fiber Optic Response System (PST-101458) is for research and educational purposes only.
# Table of Contents

## Chapter 1: Safety

1.1 Symbol Definition ............................................. 7
1.2 Warnings .......................................................... 8
1.3 Cautions .......................................................... 9

## Chapter 2: Getting Started .................................. 10

2.1 Unpacking Your System ......................................... 10
2.2 System Requirements ........................................... 12

## Chapter 3: Introduction to the Celeritas System .......... 13

3.1 Product Overview ............................................... 13
3.2 Hardware Overview – The Celeritas Console, Front Panel .. 14
3.3 Hardware Overview – The Celeritas Console, Back Panel . . 15
3.4 Hardware Overview – Celeritas BRU ................................... 16
3.5 Hardware Overview – Celeritas Joystick .......................... 17
3.6 Software Overview ............................................... 18

## Chapter 4: Software Installation .......................... 19

4.1 Before Software Installation .................................... 19
4.2 Software Installation ............................................. 20
4.3 Driver Installation ................................................. 23

## Chapter 5: Hardware Configuration .................... 26

5.1 Hardware Installation ............................................. 26
5.2 Celeritas Quick Functionality Tests ........................... 34
5.3 Celeritas BRU Quick Functionality Test ...................... 35
5.4 Celeritas Joystick Quick Functionality Test ................. 36

## Chapter 6: Hardware Operation .......................... 37

6.1 Hardware Configuration Introduction ..................... 37
6.2 Front Panel Console ............................................. 38
  6.2.1 Left and Right Device Indicators and Sleep Mode .. 38
  6.2.2 Left and Right Buttons and Indicators ......................... 39
  6.2.3 Trigger Indicator and Mask .................................. 40
  6.2.4 Reset Button .................................................. 41
6.3 Back Panel Console ............................................. 42
  6.3.1 Left and Right Fiber Inputs .................................. 42
  6.3.2 USB Port ...................................................... 43
  6.3.3 Fiber Optic and BNC Trigger Input ......................... 44
  6.3.4 External I/O Port ............................................. 45
  6.3.5 Power Input and Switch ..................................... 46
6.4 Celeritas BRU ..................................................... 47
6.5 Celeritas Joystick ................................................. 49
Chapter 1: Safety

1.1 Symbol Definition

The following symbol will be used throughout this manual as a means to alert you to potential safety hazards on the accompanying equipment.

This chapter is designed to alert you to any safety precautions associated with the Celeritas System. Read all WARNINGS and CAUTIONS before use of the Celeritas System. Psychology Software Tools, Inc. is not liable for any damage or injury resulting from misuse of this equipment.

To ensure the system is functioning properly; the procedure described in Chapter 5: Hardware Configuration, Step 5: Calibrate the Celeritas Console, Page 31 should be performed after the Celeritas System is set up and before each use to ensure the system is functioning properly.
Chapter 1: Safety

1.2 Warnings

The following Warning stickers appear on the Celeritas Console:

⚠️ WARNING: **DO NOT** take the Celeritas Console or Power Supply into the Scanner Room. These components contain ferromagnetic parts and may become projectiles in the presence of a strong magnetic field.

⚠️ WARNING: **Service to be performed by qualified service personnel only. Opening the device by non-qualified personnel will invalidate the warranty.**

⚠️ **WARNING:** Service to be performed by qualified service personnel only. Opening the device by non-qualified personnel may invalidate the warranty. See product documentation for proper procedures.

⚠️ **WARNING:** **DO NOT** expose this unit to rain or moisture to prevent fire and shock.
Chapter 1: **Safety**

### 1.3 Cautions

This section contains cautions for installation and use of the Celeritas System. These cautions must be read thoroughly before attempting to install and operate the system.

**DO NOT** power up the Celeritas System until you are instructed to do so.

**DO NOT** kink the fiber optic cables. Fiber cable bends with less than 2 inch (5.08 cm) radius may cause permanent fiber cable damage.

**DO NOT** touch or scratch the fiber optic connector faces.

**DO NOT** place any liquids on any part of the Celeritas System including the console and hand units. Liquid can enter enclosure through air ventilation causing an electrical malfunction.

**DO** replace fiber cable dust caps when the Celeritas Button Response Units (Celeritas BRUs) are not connected to prevent damaging equipment.

**DO NOT** place excessive stress on the fiber cable or connector.

**DO** inspect fiber optic cable conduit daily for tears, abnormal wear, signs of pinching, indications of being crushed, and signs of being kinked. If any of these are noticed be sure to recycle power to initiate calibration and verify proper detection of all connected devices and switches.

**DO** take steps to avoid a tripping hazard by always unwinding/untwisting the cabling any time it is being stowed or un-stowed. (For protection of the individual fiber optic cables, the plastic cable conduit is fairly rigid and does not twist. This results in a tendency for the conduit to become raveled.)
Chapter 2: **Getting Started**

2.1 Unpacking Your System

The equipment supplied for the Celeritas System is composed of the items listed below.

- **Celeritas Console**
- **Right/Left Celeritas BRU**
  
  *see individual purchase order*

- **Celeritas Joystick**
  
  *see individual purchase order*

- **Wrist Tether**
  
  *for Celeritas Joystick only*

- **10 meter fiber cable**
  
  *2 included with system purchase*

- **6 foot A-B USB cable**
Chapter 2: **Getting Started**

- 9V 2A Power Supply
  ![9V 2A Power Supply](image)
- Mountable Celeritas BRU holder
  ![Mountable Celeritas BRU holder](image)
- Mountable Celeritas Joystick holder
  ![Mountable Celeritas Joystick holder](image)
- BNC cable
  ![BNC cable](image)
Chapter 2: **Getting Started**

### 2.2 System Requirements

**Software Compatibility Requirements**
- Windows XP, Vista, 7 and 8 (32- or 64-bit)
- E-Prime 2.0 Service Pack 1

**Computer Requirements**
- Full Speed USB port

**NOTE:** Some USB 3.0 chipsets and/or drivers may be incompatible with the Celeritas System. We recommend that you connect the Celeritas System to a non-USB 3.0 port if available. Visit the PST Product Service and Support web site at [https://support.pstnet.com](https://support.pstnet.com) for updated information about USB 3.0 port compatibility.

If use with E-Prime 2.0 is intended, the computer must comply with the [minimum E-Prime 2.0 SP1 requirements](#).

**Scanner Site Requirements**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum waveguide diameter</td>
<td>0.75” (1.9 cm)</td>
</tr>
<tr>
<td>Electrical trigger (optional)</td>
<td>BNC, 5V TTL, 2μs</td>
</tr>
<tr>
<td>Optical trigger (optional)</td>
<td>Versatile Link, 2μs</td>
</tr>
</tbody>
</table>

**NOTE:** Only one trigger can be used at a time, e.g. either an electrical trigger OR an optical trigger but not both.
Chapter 3: **Introduction to the Celeritas System**

### 3.1 Product Overview

The Celeritas Fiber Optic Response System (Celeritas System) is engineered for use in MRI and MEG settings. It enables a participant in the scanner room to make responses using Celeritas Button Response Units (BRUs) and/or Celeritas Joysticks. Any combination of up to two BRUs and/or Joysticks is supported. Celeritas further enables a staff member in the control room to monitor the participant’s responses by providing real-time visual confirmation of the responses on a separate device, the Celeritas Console, via LED indicators. The Celeritas Console also includes a set of switches which can be used to simulate participant responses.

In order to support the needs of individual researchers working in shared laboratory environments, the Celeritas System provides customizable key mappings. Each Response Device (button press or Joystick movement) is mapped to a character key. For example, the index finger on the right BRU is mapped by default to the ‘2’ key. However, a researcher can change this mapping if need be, such as mapping the right index finger to the ‘y’ character rather than to the ‘2’ character. Further, multiple customized key mappings can be defined. This feature enables researchers to employ their own custom key mapping scheme while sharing the same Celeritas System.

The Celeritas System also supports communication with the scanner and other devices. The console accepts either an optical or an electrical TR signal from the scanner and forwards it to the computer that is running the stimulus presentation software, allowing the experiment to be synchronized with the scanner. The console also provides an external I/O port.

Celeritas is optimized for performance when used in conjunction with E-Prime 2.0 Service Pack 1 (SP1). However, it is also compatible out-of-the-box with any computer system that supports standard USB keyboards, mice, and joysticks; in this case, the Celeritas Response Devices act as standalone HID devices. The benefits of the E-Prime integration are detailed in **Section 7.2 Celeritas Monitor: Introduction, Page 56**. Using Celeritas as a standalone HID device is described in **Chapter 9: HID Mode, Page 89**.
Chapter 3: Introduction to the Celeritas System

3.2 Hardware Overview – The Celeritas Console, Front Panel

This is the front of the Celeritas Console. Each of the indicators and buttons are labeled below. Please take a few moments to become familiar with the component names because they will be used throughout the documentation.

1) Left Celeritas Joystick Response Indicators
2) Left Celeritas Button Indicators
3) Left Front Panel Buttons
4) Left Device Indicator
5) Right Device Indicator
6) Right Celeritas Button Indicators
7) Right Front Panel Buttons
8) Right Celeritas Joystick Response Indicators
9) Reset Button
10) Trigger Indicator
11) Trigger Mask Indicator
12) Trigger Mask Button
Chapter 3: Introduction to the Celeritas System

3.3 Hardware Overview – The Celeritas Console, Back Panel

This is the back of the Celeritas Console. Each of the inputs and ports are labeled below. Please take a few moments to become familiar with the component names because they will be used throughout the documentation.

1) Left Fiber Input
2) Right Fiber Input
3) USB Port
4) Optical Trigger Input
5) Electrical (BNC) Trigger Input
6) External I/O Port
7) Power Input
8) Power Switch
Chapter 3: Introduction to the Celeritas System

3.4 Hardware Overview – Celeritas BRU

This is the Celeritas BRU. The functional parts of the unit are labeled below. Please take a few moments to become familiar with the component names because they will be used throughout the documentation. A five-button BRU is shown below; two- and three-button BRUs are also available.

1) Celeritas BRU
2) Buttons
3) Wrist Strap
3.5 Hardware Overview – Celeritas Joystick

This is the Celeritas Joystick. The functional parts of the unit are labeled below. Please take a few moments to become familiar with the component names because they will be used throughout the documentation.

1) Buttons
2) Analog Stick
3) Hand Strap
4) Wrist Tether
Chapter 3: Introduction to the Celeritas System

3.6 Software Overview

The Celeritas System software consists of the Celeritas Device Driver, the Celeritas Monitor Application, and the Celeritas E-Prime Device. These elements are installed as part of the Celeritas System software installation and are described briefly here. Complete instructions for installing the Celeritas System software are provided in Section 4.2 Software Installation, Page 20.

Celeritas Device Driver
The Celeritas Device Driver is used to accurately timestamp any responses made with the Celeritas Response Devices and forwards the response information to the stimulus presentation computer. The Celeritas Device Driver is used by both the Celeritas Monitor Application and the Celeritas E-Prime Device to communicate with and control the Celeritas System. (If Celeritas is run in HID mode, the computer’s HID driver processes the button and/or Joystick responses rather than the Celeritas Device driver).

Celeritas Monitor Application
The Celeritas Monitor Application provides a graphical representation of the Celeritas hardware and enables the hardware components to be configured. For example, Celeritas Monitor makes changing the character key mappings a simple process. In addition, multiple users can create, save, and load their own custom key mappings. The Celeritas Monitor Application also enables the Joystick to be configured to function as a Mouse. The Celeritas Monitor Application also provides support for controlling the trigger mask, i.e. enabling or disabling the TR signal to be sent to the stimulus presentation computer.

Celeritas E-Prime Device
The Celeritas E-Prime Device supports optimized functioning with E-Prime. The Celeritas E-Prime Device Properties is accessed from within E-Prime. It is similar in appearance to the Celeritas Monitor Application and supports the same functionality, including the ability to create custom key mappings. However, the Celeritas E-Prime Device offers enhanced functionality beyond what is offered with the Celeritas Monitor Application. For example, when configuring the Celeritas Device within E-Prime, users obtain deterministic time-stamping of responses and enhanced error checking of the Response Device status at runtime. In addition, some Joystick configuration options are only available when configured within E-Prime. The remapping of Joystick keys and the creation of Joystick zones can only be done when Celeritas is configured as an E-Prime Device; these features are not available from the Celeritas Monitor Application. Perhaps most importantly, however, the Celeritas E-Prime Device enables custom key mappings to be stored within the experiment file itself (.es2 file). This offers true portability of your experiment within any shared laboratory environment, because your custom key mappings are applied regardless of how another researcher may have configured the device with the Celeritas Monitor application. This is detailed in Section 7.2 Celeritas Monitor: Introduction, Page 56.
Chapter 4: **Software Installation**

### 4.1 Before Software Installation

This chapter describes how to install the Celeritas System software. The last step in the software installation process requires the Celeritas Console; it is used to install the Celeritas Device Driver. However, **DO NOT** connect the Celeritas Console until prompted to do so. After installing the software, continue with Chapter 5: Hardware Configuration, Page 26, which describes how to setup the remaining hardware components of your Celeritas System. Then complete your Celeritas System setup by running the quick verification tests described in 5.3 Celeritas BRU Quick Functionality Test, Page 35 and 5.4 Celeritas Joystick Quick Functionality Test, Page 36.

**NOTE:** In order to complete Celeritas System software installation, you will need access to the Celeritas Console. Do not connect the Celeritas Console until prompted to do so.

**NOTE:** Please read the installation instructions completely before attempting to set up the Celeritas System.
Chapter 4: **Software Installation**

### 4.2 Software Installation

You must have administrative rights to install this software on the computer. If you do not have administrative rights, you will be unable to install the Celeritas System. If you are unsure of your administrative privileges, contact your System Administrator. We recommend manually uninstalling any older versions of the Celeritas Fiber Optical Response System software before installing any updates.

**NOTE:** The version number on the following images may not correspond to the version number on your software.

**NOTE:** If no version of E-Prime 2.0 is found on the system, or an incompatible version is found, a message box will notify you that the Celeritas E-Prime Device will not be installed. If you later want to install the Celeritas E-Prime Device, re-run the installer.

1. **Insert** the Celeritas System installation CD into your CD-ROM drive. If the Setup program does not automatically start, **navigate** to your CD-ROM drive in Windows Explorer and open Setup.exe to launch the installation.

2. **Click** “Next” when you see the window.

3. **Please read** the License Agreement and make sure that you **agree completely** with the terms and conditions described in the agreement before proceeding. Once you have read and accepted the terms of the license agreement, **click Next** to proceed with the installation.
Chapter 4: Software Installation

4) **Specify Your Name**, and **Institution** and **Optional Serial Number** or check with the System Administrator for the appropriate information. **NOTE:** The Serial Number is not required for installation, but we encourage you to enter it here. Your serial number is printed on the bottom of the Celeritas Console (“System Serial #”).

5) **Click Next** to continue the installation.

6) **Click Install** to begin the installation.
Chapter 4: **Software Installation**

7) **Wait** for the installation to complete.

8) A Windows Security dialog will open. It will ask “**Would you like to install this device software?**”. **Click Install.**

9) If the Celeritas System was installed properly, you will see the following window. **Click Finish** to complete the installation.
Chapter 4: **Software Installation**

### 4.3 Driver Installation

**NOTE:** Windows XP and Vista Users may need to restart the computer between the software installation and the driver installation. If you must restart the computer, save and close any open applications prior to restarting.

**WARNING:** **DO NOT** take the Celeritas Console or Power Supply into the Scanner Room. These components contain ferromagnetic parts and may become projectiles in the presence of a strong magnetic field.

1) **Place** the Celeritas Console in proximity of the waveguide/penetration panel so that the fiber optic cables can be fed though the waveguide. (See Chapter 5: Hardware Configuration, Page 26).

2) **Locate** the POWER connection on the back of the Celeritas Console.

3) **Plug** the appropriate end of the Power Supply into the Celeritas Console. **Plug** the power adaptor into a wall socket.

   **NOTE:** Be sure the power switch is in the OFF/O position prior to providing power to unit. Do not turn unit on until instructed to do so.

4) **Turn on** the Celeritas Console.
Chapter 4: **Software Installation**

5) **Connect** the **Type A USB** end of the **USB cable** (provided) to a **USB port** on your computer.

6) **Connect** the **Type B USB** end of the **USB cable** to the connector labeled “**USB**” on the back of the **Celeritas Console**.

5) Type A USB port and connector

6) Type B USB port and connector
Chapter 4: **Software Installation**

7) One of the **dialog boxes** shown to the right will **open** indicating the **driver software** is **installing**.

8) When the dialog box shows all **green check marks** it is complete. **Click Close** to complete installation.
Chapter 5: **Hardware Configuration**

5.1 Hardware Installation

This chapter describes how to configure the Celeritas Hardware. It documents how to connect the Celeritas Response Units to the Celeritas Console and how to prepare the console for use by running the calibration routine. This chapter assumes you have completed the software installation described in [Chapter 4: Software Installation, Page 19](#); specifically, the Celeritas Console must be placed in a reliable location in the Control Room as described in [4.3 Driver Installation, Page 23](#) before you can continue with the hardware configuration.

⚠️ **WARNING:** *DO NOT take the Celeritas Console or Power Supply into the Scanner Room. These components contain ferromagnetic parts and may become projectiles in the presence of a strong magnetic field.*

Please power off the Celeritas Console prior to continuing with this chapter. While you can work with the fiber cables and Response Devices in the Scanner Room while the Celeritas Console is powered on, we advise powering the unit off until all of the connections have been made.
Chapter 5: Hardware Configuration

Step 1: Connect fiber cables from Celeritas Console to Celeritas Response Device(s)

The fiber cables connect the Celeritas Console in the Control Room to the Celeritas Response Device(s) in the Scanner Room via the waveguide. Since the fiber cables ship with both ends unattached, it is important to identify which end connects to the Response Device before feeding the cable through the waveguide. The male connector, labeled “Control Room”, plugs into the console, and the female connector, labeled “Magnet Room”, plugs into the Response Device in the Scanner Room. Once you have identified the female connector, gently feed it through the waveguide from the Control Room into the Scanner Room. Connect the male connector to the RIGHT or LEFT fiber input in the back of the Celeritas Console. In the Scanner Room, connect the female connector to the desired Response Device. Repeat the process for the second Response Device. We recommend connecting one Response Device completely before feeding the second fiber cables through the waveguide to avoid confusing which Response Device is connected to which console input. A BRU is shown below, but the process is the same for a Celeritas Joystick.

**NOTE:** Up to two fiber cables may be connected together to create the length necessary for a participant to use the Response Device. Please be mindful not to create a tripping hazard for others in the Scanner Room.

1) In the **Control Room**, **identify** the **female connector**, labeled **Magnet Room**. While the **dust cap** is on, gently **feed** it **through** the waveguide.

2) **Remove** the **dust cap** from the **male connector**, labeled **Control Room**, and **insert** it into the **Right Fiber Input** on the back of the **Celeritas Console**.

3) **Enter** the **Scanner Room**, **remove** the dust caps from the desired **right hand response device** and **connect** it to the **fiber connector**.

4) **Follow** the same procedure listed in **Steps 1-3** to connect the **left hand Response Device** if applicable.
Chapter 5: Hardware Configuration

Step 2: Mount the Celeritas BRU and/or Celeritas Joystick Holders

Holders are provided for the BRU and Joystick units. The holders can be mounted with the provided 3M™ DualLock™ Recloseable Fasteners, or mounted more permanently where the site allows.

**NOTE:** Mounting holes are provided for a more permanent installation. Damage to the MRI Room Faraday cage may result if installed improperly. Coordinate with facilities manager prior to installation.

1) **Position** the **holder** with the attached DualLock fastener until the location is chosen. Place the holder in a location that will safely store the cables.

**NOTE:** The DualLock adhesive can damage painted surfaces when removed.

**NOTE:** The fastener can be trimmed to fit.

2) **Remove** the **fastener** from the back of the **holder**.

3) Prior to **placing** the **fastener**, **ensure** the area is **clean** and free of dust or debris.

4) **Peel** the **white backing** from the **fastener**. **Adhere** the fastener using a **pressing** and **smoothing** motion onto the intended surface.

5) **Place** the **holder into** the mounted fastener.

6) **Slide** the **hand unit** into the **holder**, as shown to the right, **placing** the **fiber optic cable** into the groove at the rear of the holder. **Wrap** the remainder of the **cable around** the holder.

7) **Follow** the same procedure listed in **steps 1-6** to **mount** the **Joystick holder** if applicable.
Chapter 5: Hardware Configuration

Step 3: Connect the Celeritas Console to the computer

**NOTE:** This step should have already been completed in Chapter 4. If for some reason you have not completed this step, perform it now; otherwise go to Step 4.

Use the USB cable (provided) to connect the Celeritas Console to your computer’s USB port.

1) **Plug** the appropriate end of the **USB cable** into the **Celeritas Console** and the other end into the **USB port** on the computer.
Chapter 5: **Hardware Configuration**

**Step 4: Connect the Power Supply**

**NOTE:** The Power Supply should have already been connected in Chapter 4, and the power turned OFF at the start of this chapter. If the Power Supply has not been connected, do so now.

Before the Celeritas Console can be powered on and calibrated, the Power Supply must be connected to the console and plugged into a wall socket.

Make sure that the power is OFF, before continuing with Step 5.

1) *Turn off* the Celeritas Console.
Chapter 5: Hardware Configuration

Step 5: Calibrate the Celeritas Console

Each time the Celeritas Console is powered on, it automatically goes through an initialization and calibration routine. The calibration routine can also be initiated by pressing the Reset button or power cycling the Celeritas Console. Calibration occurs in two phases. During phase one, the Celeritas Console searches for any connected Response Devices by blinking all of the front panel button indicators quickly seven times. During the second phase of calibration, the Celeritas Console indicates which type of Response Devices are attached. Additionally, the console reports all of the buttons that have been detected by slowly flashing the corresponding button indicators four times. If no Response Device is found, the button indicators will remain off, while the device indicators blink slowly four times. When the four slow flashes stop, calibration is complete and Celeritas is ready to send responses to a computer.

NOTE: The Reset button must be pressed any time a Celeritas Response Device is attached, removed, or replaced in order to activate recalibration and initialization. Also, press the Reset button at the beginning of each day to compensate for any minor fiber optic cable and connection changes, such as coiled cabling or dirty connectors.

1) **Power** the Celeritas Console on.

2) **Calibration** occurs immediately and automatically. **All ten** of the Celeritas Console’s button indicators will **flash quickly seven times**. Then any fiber buttons that are detected will **flash slowly four times**.

3) **Press** each button on the Celeritas BRU or Joystick and **watch** for the illumination of the corresponding green LED on the Celeritas Console to verify proper functioning. **NOTE:** If you missed the calibration phase, calibration can be initiated at any time by pressing the Reset button.
Chapter 5: **Hardware Configuration**

**Step 6: Trigger Input Installation**

The Celeritas Console relays the Trigger Signal from the scanner to the experiment computer, so that it may determine when to start the experiment. The Celeritas Console supports two types of trigger inputs, optical or electrical (BNC). Determine which you have access at your site to and connect the appropriate connection from the scanner to the Celeritas Console.

**NOTE:** If **both** optical and electrical triggers are available, **do not** connect them simultaneously.

**Optical Trigger Input Installation:**
1) **Locate** the TRIGGER IN OPTICAL connection on the back of the Celeritas Console.

2) **Insert the optical fiber** into the TRIGGER IN OPTICAL input.

**Electrical Trigger Input Installation:**
1) **Locate** the TRIGGER IN BNC connection on back of the Celeritas Console.

2) **Insert** the electrical connection into the TRIGGER IN BNC input.
Chapter 5: **Hardware Configuration**

In order for the Celeritas Console to function properly it is very important that only one Trigger Input is used at a time.

**NOTE:** If *both* optical and electrical triggers are available, *do not* connect them simultaneously.
Chapter 5: Hardware Configuration

5.2 Celeritas Quick Functionality Tests

You have now configured the hardware so that the Celeritas Response Devices are connected to the Celeritas Console and the Celeritas Console is connected to the stimulus presentation computer. This chapter presents quick functionality tests for each type of Celeritas Response Device. We recommend that you perform the tests for your Response Devices prior to continuing with Chapter 6: Hardware Operation, Page 37, which provides detailed information about the hardware operation.

Recall that the Celeritas Console provides the operator with immediate visual confirmation of the participant’s responses by way of the front panel buttons. In addition, responses made with the BRU can be monitored in any text editor, and responses made with the Joystick can be monitored in the Game Controller Applet. The quick functionality tests illustrate both of these capabilities, and offer a simple way to confirm operation of the hardware.
Chapter 5: Hardware Configuration

5.3 Celeritas BRU Quick Functionality Test

Before continuing, be sure that you have connected at least one (or both) of the Celeritas BRU(s) to the Celeritas Console, the console is powered on and you have a text editor installed on your computer. For this test, you will open the text editor, press the buttons on the Celeritas BRU, and determine if the button presses match the default Celeritas BRU mappings. The default mappings are listed in Section 6.4 Celeritas BRU, Page 47.

1) Connect one or both Celeritas BRUs. (See Step 1: Connect fiber cables from Celeritas Console to Celeritas Response Device(s), Page 27). Press the Reset button on the Celeritas Console, and allow the unit to calibrate.

2) Open a text editor like Notepad. (On a Windows machine go to Start > Find > Notepad.)

3) Press the buttons on the button response unit(s). NOTE: Responses can also be made via the front panel of the Celeritas Console.

4) The text editor should display the default button mappings when the corresponding buttons are pressed. To simulate a Trigger Response, see Section 6.2.2 Left and Right Buttons and Indicators, Page 39.
Chapter 5: Hardware Configuration

5.4 Celeritas Joystick Quick Functionality Test

Disconnect either (or both) Celeritas BRU(s). Connect the Celeritas Joystick to the Celeritas Console, and press the Reset button. Open the System Game Controllers Applet (Windows OS), or use the shortcut in the Start Menu under the Celeritas folder. Move the Celeritas Joystick analog stick as you observe the Game Controllers Applet to verify the axes are moving as expected. The default mappings are listed in Section 6.5 Celeritas Joystick, Page 49.

NOTE: If you do not know how to access your operating system’s game controllers, ask your System Administrator.

1) If you have not connected the Celeritas Joystick then do so now (See Step 1: Connect fiber cables from Celeritas Console to Celeritas Response Device(s), Page 27). Press the Reset button on the Celeritas Console, and allow the unit to calibrate.

2) On a Windows machine go to Start Menu > Celeritas > Game Controllers Applet or open the Game Controller Applet specific to your operating system. Open the Properties dialog.

3) While on the Test tab, use your thumb to move the Celeritas Joystick analog stick around to verify the computer is detecting the motion. This is indicated by the motion of the “+” within the box. NOTE: The mappings shown are for one Celeritas Joystick. If using two Celeritas Joysticks see Section 6.5 Celeritas Joystick, Page 49 for details.

4) To verify the Celeritas Joystick buttons, press each button on the Joystick. The circles under the Buttons will light red when the corresponding button is pressed. Each Celeritas Joystick has four buttons.
Chapter 6: **Hardware Operation**

6.1 **Hardware Configuration Introduction**

The next section of the documentation describes the functionality of the indicators and buttons on the front of the Celeritas Console, inputs and ports on the back of the Celeritas Console, and Response Devices.
Chapter 6: Hardware Operation

6.2 Front Panel Console
6.2.1 Left and Right Device Indicators and Sleep Mode

The front of the Celeritas Console contains several buttons and LEDs, each with different functionality. Highlighted below are the indicators that show which devices are connected. The Celeritas System can support any combination of up to two Response Devices at a time, either Celeritas BRUs and/or Celeritas Joysticks. The top indicator is labeled with a hand icon representing a Celeritas BRU. The bottom indicator is labeled with a Joystick icon representing a Celeritas Joystick. When an indicator is lit, it designates which of the available devices are active.

If the device is unused for two hours – e.g., no buttons are pressed, no axes are moved, no USB communications occur, no unmasked Triggers are sent – then the transmitters go into Sleep Mode to prolong their life. While in Sleep Mode, the device indicators rotate sequentially in a clockwise direction. Pressing any button on the console or Response Device, receiving an unmasked trigger, or having any USB communication will wake up the device. Conversely, axis movements on the Joystick will not wake up the device.

The transmitters are still pulsed periodically in Sleep Mode, so that a fiber switch press on the Response Device will wake up the device. However, the pulse is periodic and brief. Therefore, if the device wakes up from a fiber switch, then the timing of that fiber switch response may be inaccurate. For this reason, we recommended that you wake up the device from Sleep Mode by pressing one of the Celeritas Console’s front panel buttons before collecting any data.

1) Left Celeritas BRU Device Indicator
2) Right Celeritas BRU Device Indicator
3) Left Celeritas Joystick Device Indicator
4) Right Celeritas Joystick Device Indicator
Chapter 6: Hardware Operation

6.2 Front Panel Console
6.2.2 Left and Right Buttons and Indicators
The Celeritas Console supports the use of up to two Response Devices simultaneously, with up to five response buttons on each Response Device. The front panel display has ten buttons and indicator LEDs. When the switch that corresponds to the button is activated via a fiber button press on a connected Response Device, the LED above the button on the console is lit. The LED thus provides immediate visual feedback of the participant responses to the Control Room technician.

Further, participant responses can be simulated by pressing the Celeritas Console buttons. Advanced users can utilize the back panel External I/O port to simulate a response. The simulated responses are registered as the current mappings of the connected device. The default mappings for Response Devices are described in Section 6.4 Celeritas BRU, Page 47 and Section 6.5 Celeritas Joystick, Page 49. The LED above a button also lights up for simulated responses.

The LEDs are also used during the second phase of calibration. The LEDs blink to indicate which buttons are detected by the Celeritas Console. The number of buttons that are detected will vary depending on the type of Response Device. A standard Celeritas Button Response Unit has five buttons; when detected the Celeritas Console blinks all five LEDs. The Celeritas Joystick has four buttons; when detected the Celeritas Console only blinks four LEDs.

The console buttons can also be used to load Front Panel profiles. Front Panel profiles are pre-configured button mappings that are saved in the Celeritas Console hardware. The mappings control what keyboard key is transmitted to the stimulus computer when a button is pressed and when a trigger is received. These profiles can only be modified using the Celeritas Monitor software; see Chapter 7: Software Interface and Operation, Page 55 for details. However, once a profile is modified it can be activated on the console itself without the use of Celeritas Monitor. When the Celeritas Console is powered on the administrator profile is loaded into Front Panel profile 1. The default mappings in this profile correspond to the numbers printed below on each button on the Front Panel of the Celeritas Console. To activate another a Front Panel profile, hold down the Reset button and then hold the Front Panel button corresponding to the desired profile for four seconds. Once the profile is loaded the calibration sequence will begin. To learn more about modifying profiles, see Section 7.2 Celeritas Monitor, Page 57.

Finally, the Celeritas Console buttons can be used to simulate a Trigger Response. To simulate a Trigger Response, hold down the Mask button and press any of the front panel buttons (1-A). The Trigger is mapped as an “=”. Using the Mask button in this way does not change the state of the Trigger Mask.
Chapter 6: Hardware Operation

6.2 Front Panel Console
6.2.3 Trigger Indicator and Mask

The Trigger indicator LED is located in the upper right of the Celeritas Console. It is labeled Trigger and displays incoming trigger pulses from the scanner. When the console is receiving triggers, the light blinks as the Celeritas Console recognizes each trigger. The Trigger indicator blinks at a maximum rate of 2 Hz. Even if triggers generated are faster than 2 Hz, e.g., the triggers are generated for each slice instead of the whole volume, the Trigger indicator only blinks at 2 Hz. The trigger is transmitted by the Celeritas Console as a key press represented by the “=” character.

In HID Mode, the Trigger key will be sent at a maximum of 500 Hz; for very short trigger pulse widths, the Trigger release may be delayed by one millisecond. In Celeritas Mode, the Trigger key can be sent in excess of 1000 Hz and there is never any release delay.

Directly below the Trigger indicator LED are the Mask indicator LED and Mask button. The Mask is used when trigger output is not desired, similar to how a mute button on a phone is used. It also can be used when it is necessary to enter information into the stimulus presentation computer that is not in response to the experimental stimuli that the trigger will interfere with, e.g. participant information or setup commands for the experiment. When the Celeritas Console allows a trigger pulse to be sent to the stimulus computer the Trigger indicator LED blinks green and the Mask indicator LED is not lit. Once enabled, the Mask LED is lit yellow. The Trigger indicator blinks yellow when the Celeritas Console is masked, alerting the user that the Celeritas Console is able to see the triggers but it is not transmitting them to the stimulus display computer. To toggle the Mask state, press the Mask button.

The Mask button can also be used to simulate trigger pulses. See Section 6.2.2 Left and Right Buttons and Indicators, Page 39, about simulating trigger pulses.
Chapter 6: **Hardware Operation**

6.2 Front Panel Console

6.2.4 Reset Button

The Reset button is located next to the Mask button. When the Celeritas System is not collecting/transmitting responses, the Reset button can be used to recalibrate the connected Response Devices.

**NOTE:** *If a Response Device is attached or removed from the console, then the Reset button must be pressed so that the Response Device can be calibrated before it is used.*

For details on calibration, see Chapter 5, Step 5: Calibrate the Celeritas Console, Page 31.

The Reset button can also be used to activate Front Panel profiles. See Section 6.2.2 Left and Right Buttons and Indicators, Page 39, for more information.
Chapter 6: **Hardware Operation**

6.3 Back Panel Console

6.3.1 Left and Right Fiber Inputs

The back of the Celeritas Console is equipped with several ports and inputs. The inputs highlighted below are the LEFT and RIGHT fiber optic inputs. These inputs connect the fiber cables to where they are coming from the Response Devices. As noted previously, the Celeritas System can support any combination of two Celeritas BRUs and Joysticks at a time.

1) Left Fiber Input
2) Right Fiber Input
Chapter 6: **Hardware Operation**

6.3 Back Panel Console

6.3.2 USB Port

The USB port connects the Celeritas Console to the stimulus presentation computer. The USB port is Full Speed only.

1) USB Port
Chapter 6: **Hardware Operation**

### 6.3 Back Panel Console

#### 6.3.3 Fiber Optic and BNC Trigger Input

The Celeritas Console supports two types of Trigger connections, fiber optic and BNC. Please speak with your MR Center’s technical staff to determine which type of input is utilized at your site. Please make sure to use only one input at a time.

**NOTE:** If *both* optical and electrical triggers are available, **do not** connect them simultaneously.

The Celeritas Console’s Trigger In BNC port expects a 5V TTL signal. The minimum trigger pulse width is 2μs.

1) Optical Trigger Input  
2) Electrical (BNC) Trigger Input
Chapter 6: Hardware Operation

6.3 Back Panel Console
6.3.4 External I/O Port

The External I/O port supports communication with a third-party device. Each External Input supports a software programmable debounce period. The External Inputs allow a third-party device to simulate participant responses in a manner identical to the Front Panel buttons. The External Outputs allow a third-party device to be notified of participant responses in a manner identical to the Front Panel Response Indicators. The External I/O applies only to Response Device buttons, but not any Celeritas Joystick axes. The trigger pulse is also replicated; trigger pulses from this port will be 10 ms wide, regardless of the duration of the actual trigger pulse, so the maximum trigger frequency for this output is 100 Hz.

NOTE: To view the pinout diagram, see Section 8.1.1 Pinout, Page 86.

1) External I/O Port
Chapter 6: Hardware Operation

6.3 Back Panel Console
6.3.5 Power Input and Switch

The Celeritas Console requires a 9V DC Power Supply (included). Next to the power input is the power switch. This switch turns the Celeritas Console on and off when the Power Supply is connected and plugged into a wall socket. The power switch indicator turns green when the console is receiving power. Note that cycling the power, as well as hitting the Reset button on the Front Panel Console, results in a system calibration. See Chapter 5, Step 5: Calibrate the Celeritas Console, Page 31 for details.

1) Power Input
2) Power Switch
Chapter 6: Hardware Operation

6.4 Celeritas BRU

The Celeritas BRU is designed for participants to make responses to stimuli in a magnetic environment. The units fit the right or left hand. The BRUs offer two custom adjustments on the bottom of the wrist sled. The unit can be expanded to accommodate larger hands, and it can be angled to accommodate differences in the hand’s resting position. Each unit has two, three, or five buttons. The index finger button on the five button units has a raised bump to help participants orient their fingers to the correct buttons. The unit attaches to the participant at the wrist using a VELCRO wrist strap.

An MRI emergency squeeze ball can be used with the BRU by placing it between the palm of the hand and the BRU. Route the squeeze ball’s cord inside the BRU’s wrist strap along the participant’s wrist and secure it so the emergency squeeze ball remains within immediate reach of the participant. **Do not pinch the emergency squeeze ball cord.**

The Celeritas BRU can be utilized and optionally configured in one of two ways. The Celeritas BRU functions as a HID keyboard by default. The Celeritas BRU can be used out-of-the-box with if the default key mappings and system settings are acceptable. When used as a HID device, the BRU key mappings are configured with the Celeritas Monitor Application.

Alternatively, when the BRU is utilized in conjunction with E-Prime, it functions as a custom E-Prime device. Within E-Prime, the Celeritas BRU can be configured to emulate either a Keyboard or Mouse device; such a configuration is particularly useful when the E-Prime experiment development occurs in a different location than the data collection (e.g., experiment development in an office or lab environment vs. data collection at the MRI scanner site). When used in conjunction with E-Prime, the BRU key mappings are configured within the Celeritas Device Properties, which are accessed within the E-Studio application. Configuration and emulation are described in **Chapter 7: Software Interface and Operation, Page 55.**

The default mappings of the BRU response buttons to character keys is shown in the table on the next page. The default mappings are the same regardless of whether the BRU is used as a HID device or as a custom E-Prime Device. The mappings assume that a left-handed BRU is connected on the Left Fiber Input and a right-handed BRU is connected on the Right Fiber Input. Note that (by default) the BRU connected on the right always maps to the characters keys 1-5, and the BRU connected on the left always maps to the character keys 6 – a. Therefore, the BRU on the left always defaults to keys 6 through a, even if there it is the only BRU connected to the console.
Chapter 6: Hardware Operation

NOTE: Please note that what appears on the screen may differ slightly from what is shown here.

Default Mappings

The Celeritas Console can also be used with a 2-button or 3-button Celeritas BRU. These reduced complexity units may be appropriate when working with younger, older, or impaired participants. Unlike the 5-button units, the 2- and 3-button units do not come in a left-hand and right-hand version. The key mappings for these units are shown below.

5- Button BRU Default Mappings:

<table>
<thead>
<tr>
<th>BRU Button/Finger Position</th>
<th>Left Hand:</th>
<th>Right Hand:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button 1/Thumb</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>Button 2/ Index</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>Button 3/ Middle</td>
<td>8</td>
<td>3</td>
</tr>
<tr>
<td>Button 4/ Ring</td>
<td>9</td>
<td>4</td>
</tr>
<tr>
<td>Button 5/ Pinky</td>
<td>a</td>
<td>5</td>
</tr>
</tbody>
</table>

The Trigger Pulse is mapped to “=”

The Celeritas Console can also be used with a 2-button or 3-button Celeritas BRU. These reduced complexity units may be appropriate when working with younger, older, or impaired participants. Unlike the 5-button units, the 2- and 3-button units do not come in a left-hand and right-hand version. The key mappings for these units are shown below.

2- Button BRU Default Mappings:

<table>
<thead>
<tr>
<th>BRU Button</th>
<th>Left Hand:</th>
<th>Right Hand:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button 1</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>Button 2*</td>
<td>7</td>
<td>2</td>
</tr>
</tbody>
</table>

3- Button BRU Default Mappings:

<table>
<thead>
<tr>
<th>BRU Button</th>
<th>Left Hand:</th>
<th>Right Hand:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button 1</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>Button 2</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>Button 3*</td>
<td>8</td>
<td>3</td>
</tr>
</tbody>
</table>

Each of the fiber buttons on the BRUs map to the Celeritas Console LEDs and buttons. For each button press on the response unit, the corresponding LED lights up as visual confirmation of the participant’s response. Further, the Celeritas Console button beneath the LED can be pressed to simulate a button press on the Response Device, e.g., in case the operator needs to make a response on behalf of the participant.
6.5 Celeritas Joystick

The Celeritas Joystick is designed for participants to navigate and/or make responses to stimuli in a magnetic environment. Each device has four buttons and one two-axis analog stick. To use the device, place the participant into a supine position. Attach the wrist tether around the participant’s wrist and slide their fingers between the hand strap and Celeritas Joystick’s body. The Joystick’s body can rest comfortably on or beside the participant’s upper thigh for the duration of the research study. Regardless of the orientation of the Joystick’s body, to move forward press the analog stick towards the top of the Celeritas Joystick. The relationship between the analog stick movement and the Joystick’s cross hair is illustrated in the Analog Stick Movement figure below.

An MRI emergency squeeze ball can be used with the Joystick by placing it beside the Joystick and the hand. Route the squeeze ball’s cord inside the Joystick’s wrist tether and secure it so the emergency squeeze ball remains within immediate reach of the participant. **Do not pinch the emergency squeeze ball cord.**

The Celeritas Joystick can be utilized and optionally configured in one of two ways. The Celeritas Joystick functions as a HID Joystick by default, but can be configured to function as a HID mouse instead. Alternatively, when the Joystick is utilized in conjunction with E-Prime, it functions as a customized E-Prime device. Within E-Prime, it can be configured to emulate a Joystick, Mouse, or Keyboard Device; such a configuration is particularly useful when the E-Prime experiment development occurs in a different location than the data collection (e.g., experiment development in an office or lab environment vs. data collection at the MRI scanner site).
Chapter 6: **Hardware Operation**

When used as a HID device, the Joystick is configured with the Celeritas Monitor Application. When used in conjunction with E-Prime, the Joystick is configured via the Celeritas Device Properties within the E-Studio application. The configuration functionality is documented in **Chapter 7: Software Interface and Operation, Page 55**. However, the Joystick can be used out-of-the-box with no customization if the default settings are acceptable. This is true regardless of whether the Joystick is used as a HID device or as a custom E-Prime device.

Before reviewing the default key mapping tables, you should review the following information. First, the tables include a row for “Console Button or External Input”. Celeritas Joystick has four buttons, but the Celeritas Console has five buttons and indicators. To take full advantage of this, the Celeritas Joystick includes a virtual fifth “button”. A press by this fifth “button” can be simulated by pressing the corresponding button on the Celeritas Console or by processing input that is retrieved from the External I/O connector. The experimenter or control room technician could use this fifth button programmatically. For example, in a gaming scenario, the experimenter could press the fifth button on the console to bring up a menu that allows the game to be paused or completed.

**Default Mappings**

Further, in contrast to the BRUs, the Celeritas Joystick’s default mappings differ based on how the device is being used. As a HID Device, the Joystick buttons map to Joystick responses (i.e. Joy1, Joy2, etc.). When used as a custom E-Prime device, the Joystick buttons map to responses (i.e. response 1, response 2, etc.)

Lastly, when two Joysticks are connected then one is designed as the Primary and one is designated as the Secondary. The Primary designation always affects the axes that the Joystick controls, with x/y controlled by the Primary Joystick and the z/rx controlled by the Secondary Joystick. Further, when used as a HID device, a single Joystick is treated as the Primary Joystick and maps to the first five responses; this is not the case when using the Joystick as a custom E-Prime device.
Chapter 6: Hardware Operation

The default mappings for the Joystick when used as a HID device are shown below:

<table>
<thead>
<tr>
<th>Joystick Button</th>
<th>Secondary Joystick</th>
<th>Primary Joystick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Left</td>
<td>Joy6</td>
<td>Joy1</td>
</tr>
<tr>
<td>Top Right</td>
<td>Joy7</td>
<td>Joy2</td>
</tr>
<tr>
<td>Back Top</td>
<td>Joy8</td>
<td>Joy3</td>
</tr>
<tr>
<td>Back Bottom</td>
<td>Joy9</td>
<td>Joy4</td>
</tr>
<tr>
<td>Console Button or External Input</td>
<td>Joy10</td>
<td>Joy5</td>
</tr>
<tr>
<td>Axes</td>
<td>z/rx</td>
<td>x/y</td>
</tr>
</tbody>
</table>

When used as a HID device, a single Celeritas Joystick corresponds to the Joystick buttons 1-5 regardless of whether it is connected to the LEFT or RIGHT. Stated another way, a single Joystick is always treated as the Primary Joystick when used as a HID device (see column labeled “Primary Joystick”). If two Joysticks are used, then the Left Joystick is treated as the Primary Joystick by default. (The Primary Joystick designation can be changed in Celeritas Monitor).

When utilized as a custom E-Prime device, then different defaults apply. First, the console side (Right or Left) determines the default mapping: the Right Joystick maps to responses 1-5 and the Left Joystick maps to responses 6 - {JOY10}. If two Joysticks are connected then the Left is treated as the Primary Joystick, but the Left remains mapped to Responses 6 through {JOY10}.

<table>
<thead>
<tr>
<th>Joystick Button</th>
<th>Left Joystick</th>
<th>Right Joystick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Left</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>Top Right</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>Back Top</td>
<td>8</td>
<td>3</td>
</tr>
<tr>
<td>Back Bottom</td>
<td>9</td>
<td>4</td>
</tr>
<tr>
<td>Console Button or External Input</td>
<td>{JOY10}</td>
<td>5</td>
</tr>
<tr>
<td>Axes</td>
<td>z/rx</td>
<td>x/y</td>
</tr>
</tbody>
</table>
Chapter 6: Hardware Operation

6.6 Celeritas Joystick Modes (used in E-Prime 2.0 only)

The Celeritas Joystick operates in one of three Cursor Modes: Default Zone, Custom Zone and Pointer Mode. The modes allow you to manipulate the Celeritas Joystick’s resolution. Joysticks generally have much lower resolutions than displays, so that the smallest motions on the Joystick can result in the cursor skipping many pixels on the display. Sometimes the default Joystick resolution is appropriate for the stimulus presentation, and other times you may wish to change the resolution so it is concentrated over the stimulus.

The Default and Custom Zones modes also support Smoothing, which affects how movements of the Celeritas Joystick’s analog stick appear on the screen. The Celeritas Joystick also has a configurable “dead zone”. Dead Zone refers to the locations on either side of physical center where the Celeritas Joystick does not register movement. When released, joysticks do not always return to the exact center, which can lead to unintended responses, such as a virtual character who continues walking forward when they should stop moving. The Dead Zone is used to prevent the collection of such unintended responses by ensuring that locations close to center are also considered center.

Smoothing, Dead Zones, and Cursor Modes are described briefly below. For many users, the default settings for these entities are adequate. Some users may want to modify these entities. To do so requires writing scripting in E-Prime. For details about the E-Basic commands that are used to configure these modes, see the Celeritas E-Basic Command Reference. This reference can be accessed from either the Celeritas entry on the Start Menu or from within the Celeritas Device Properties window in E-Prime.

Cursor Mode and Smoothing are independent for the Left and Right Joysticks, such that one Joystick could be in Custom Smoothing Cursor Mode and the other could be in Pointer Mode.

6.6.1 Smoothing

Smoothing is an optional setting for the Default and Custom Zone Cursor Modes. It is on by default. Smoothing introduces a small amount of lag in the axis values for the Celeritas Joystick responses, in exchange for a more realistic cursor motion that travels smoothly from one point on the display to the next. Usability testing has found that the smooth cursor motions are generally less distracting for users.

Smoothing is controlled by three properties: the Joystick Smoothing Left/Right property, the Joystick Smoothing Interval property, and the Joystick Smoothing Factor property.

6.6.2 Dead Zone Configuration

The DeadZone property of CeleritasDevice is used to control the Celeritas-mode Dead Zone. Movement between locations within the Celeritas-mode dead zone will not generate extra responses, potentially minimizing excess data traffic. However, the DeadZone property currently defaults to zero for maximum compatibility with the Default and Custom Zone Cursor Modes. Therefore, all movements generate responses, and the Default and Custom Zone Cursor Modes configured to produce a value of zero for locations within the dead zone.
Chapter 6: **Hardware Operation**

6.6.3 Cursor Modes

6.6.3.1 Default Zone Cursor Mode

Default Cursor Mode scales the Celeritas Joystick responses proportionally so that each physical movement outside of the dead zone results in an equally proportional logical movement of the cursor toward its limit. Keep in mind due to the difference between the display and Joystick resolution, it is not always possible for the cursor to visit a given display pixel. The default zones cannot be changed. In addition, this cursor mode uses absolute positioning, so if the Joystick physically returns to center, the cursor will logically return to center as well. Smoothing is an optional setting in this mode.

6.6.3.2 Custom Zone Cursor Mode

Custom zones allow an experiment to define every point that the cursor can reach, allowing the Celeritas Joystick’s full range of motion to be concentrated on critical areas of interest while avoiding unused areas of the display. Due to the customization of the zones, the movement of the adjusted response may not be proportional to that of the physical Joystick. For example, if the stimulus consisted of four boxes in each corner of the screen, such as the CeleritasJoystickHitTest sample, then custom zones could be specified so that all of the potential logical responses to the Joystick’s physical motions outside of the center position would be located within one of the boxes. With default zones, only a fraction of the potential Joystick’s physical motions, determined by the ratio of display pixels in the boxes over the total number of display pixels, would place the cursor inside the boxes.

This cursor mode uses absolute positioning, so if the Joystick physically returns to center, the cursor will logically return to center as well. Smoothing is an optional setting in this mode.

6.6.3.3 Pointer Mode

The Pointer Mode most closely resembles a standard mouse. Pointer Mode uses relative motion to “push” the cursor around the display; the cursor moves up while the Joystick is pushed forward, but when the Joystick is released, the cursor stays where it was instead of returning to center. In contrast to the previous Cursor Modes, it is possible to visit every pixel with Pointer Mode.

Setting a Celeritas Joystick to emulate into the Mouse device will automatically cause that Joystick’s Cursor Mode to be configured for Pointer Mode. Setting the Celeritas Cursor Mode to Pointer will cause the cursor to return to the center of the logical bounds as defined by the Celeritas.SetBounds subroutine. If two Joysticks are configured for Pointer mode, only the Joystick configured as Primary will attach to the mouse cursor.

Pointer mode cooperates with the Mouse device such that Celeritas will know when something else moves the cursor. Thus, the cursor can be moved to an arbitrary display pixel using the appropriate subroutines on the Mouse device, and if the “real” mouse is moved during the experiment then the Celeritas cursor will follow. Combined with a Celeritas Joystick emulating the Mouse device, existing experiments using a mouse can be quickly and easily be upgraded to operate with Celeritas.
Chapter 6: Hardware Operation

Smoothing does not apply to Pointer mode. Instead, the SetJoystickPointerZone variants can be used to control how fast the cursor moves for each physical Joystick location. This allows the speed of small and large movements to be configured independently. That is in contrast to the Joystick Pointer Interval property, which controls how often the Pointer cursor is updated. This means the Joystick Pointer Interval simultaneously affects all movements, large or small. If emulating a Mouse device, then any Joystick button configured as ‘1’ will be the Left mouse button, ‘2’ will be the Right mouse button, and ‘3’ will be the Middle mouse button. If this configuration is not desirable, you can change the button mappings.

6.7 HID Mouse Mode

The Celeritas Joystick can be configured to operate as a HID mouse. The HID Mouse is accessible from the Celeritas Monitor Application and therefore does not require E-Prime. If you are in HID Mouse Mode and release the analog Joystick, the cursor will not move back to the zero position. Instead, it will stay at the current on screen location, behaving like a standard desktop mouse.

Celeritas Monitor’s Edit menu includes a check box named Mouse Mode. When checked, the Joystick will connect to the computer as if it were a standard mouse in a manner quite similar to the description in Pointer Mode above.

The Mouse Mode setting is stored as part of the key mapping profile. Therefore, the Mouse Mode setting for a Celeritas Joystick can be customized by changing profiles on the front panel, or by loading a profile file within Celeritas Monitor.

By default, the buttons on the neck of Joystick will be the left (top button, default mapping 3) and right (bottom button, default mapping 4) respectively. The button to the left of the analog stick (default mapping 1) is the middle mouse button and button to the right of the analog stick (default mapping 2).

Like Pointer Mode, if there are two joysticks attached while Mouse mode is active, the Primary Joystick (as defined in the Edit menu in Celeritas Monitor) is used for controlling the mouse, while the Secondary Joystick is then treated as the Primary (i.e. it controls X and Y axes instead of Z and RX axes).

<table>
<thead>
<tr>
<th>Joystick Button</th>
<th>Secondary Joystick (if any)</th>
<th>Primary Joystick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Left</td>
<td>Joy1</td>
<td>Middle</td>
</tr>
<tr>
<td>Top Right</td>
<td>Joy2</td>
<td>Thumb1</td>
</tr>
<tr>
<td>Back Top</td>
<td>Joy3</td>
<td>Left</td>
</tr>
<tr>
<td>Back Bottom</td>
<td>Joy4</td>
<td>Right</td>
</tr>
<tr>
<td>Console Button or External Input</td>
<td>Joy5</td>
<td>Thumb2</td>
</tr>
<tr>
<td>Axes</td>
<td>x/y</td>
<td>mouse cursor</td>
</tr>
</tbody>
</table>
7.1 Introduction

As mentioned in the previous chapter, the Celeritas Response Devices can be configured in two ways. To utilize the Response Devices as HID devices, launch the Celeritas Monitor application. To utilize the Response Devices as customized E-Prime devices, open the Celeritas Device Properties Window from within E-Studio. The remainder of this chapter examines each of these configuration options.
Chapter 7: **Software Interface and Operation**

### 7.2 Celeritas Monitor: Introduction

**Configuring your HID Response Devices with Celeritas Monitor Software**

The Celeritas Monitor software modifies and loads the key mappings, verifies the Celeritas Console programming, and provides an alternate visualization of device mappings.

**NOTE:** While in the Celeritas Monitor Application, the Control, Shift, and Alt keys cannot be mapped to buttons.

As mentioned previously, the Celeritas Monitor includes the following features:

- A graphical representation of the Response Devices that are connected to the Celeritas Console.
- Status information about the buttons on the devices.
- Visual confirmation of the key mappings for the connected devices and for the trigger mask.
- The ability to remap the BRU buttons to different keys.
- The ability to remap the trigger signal to another key.

Celeritas Monitor also supports the creation of up to 10 sets of customized key mapping configurations. These configurations can be exported to files on the computer or stored on the console itself. All of these features are explored in this section.

The default mappings on the Celeritas Joystick **CANNOT** be remapped with Celeritas Monitor. The defaults can only be re-mapped by configuring the Joystick as an E-Prime Device via the Celeritas Device Properties within E-Prime. See **Section 7.3 Celeritas Device in E-Prime 2.0, Page 62** for details.

The remainder of this chapter demonstrates how to use the Celeritas Monitor Application and how to utilize the Celeritas Device Properties from within E-Prime. In order to complete the E-Prime 2.0 tutorials, you will need a computer with E-Prime 2.0, the Celeritas System software already installed. If you have not installed E-Prime 2.0 please stop now and complete the E-Prime 2.0 installation, and if you plan to use Celeritas Mode and have not installed the Celeritas System software, please refer to **Section 4.2 Software Installation, Page 20**. The tutorials assume you are familiar with using E-Prime 2.0 to build behavioral experiments. If you are new to using E-Prime 2.0 it is suggested that you work through all tutorials included in the **E-Prime 2.0 Getting Started Guide** prior to beginning this tutorial series.

**NOTE:** We recommend using emulation in all of your experiments. Emulation gives you the flexibility to test and develop your experiment without the need for the development computer to be connected to the Celeritas System. During experiment development, the device that is being emulated, such as a keyboard, can be used to make responses. When the Celeritas System becomes available, typically when ready for data collection at the MRI Scanner Site, no changes are needed to the E-Studio (.es2) file; you can simply use the Celeritas hardware to make responses rather than the keyboard. If you chose not to emulate a keyboard or standard desktop joystick in the experiment, then you must add a Celeritas Input Mask to any response collection object.
Chapter 7: **Software Interface and Operation**

### 7.2 Celeritas Monitor

#### 7.2.1 Front Panel Profiles and Diagnostics

**Summary:**
The Celeritas Monitor application makes it simple to change key mappings for a BRU. Each group of key mappings can be either saved as a profile on the computer, or saved on the console as a Front Panel profile. Further, the console enables up to 10 different Front Panel profiles to be saved. You can create and save a profile with Celeritas Monitor without having the Celeritas Console present. This is convenient when the Celeritas Console is not readily available, such as when research groups work with off-site labs, or when experiment development and testing occur at a different location than where the experiment running and data collection occur.

The Celeritas Monitor also provides status information about the attached Response Devices, including when a fiber optic button was not detected during the Calibration process. Non-detected buttons appear in the interface as red buttons, while detected buttons appear as blue buttons. (The console itself provides similar information by flashing only the LEDs associated with the buttons that are detected during Calibration.)

Lastly, just as the Celeritas Console provides feedback about which button is pressed by flashing the LED that is associated with that button, the Celeritas Monitor interface also provides visual confirmation about a button press. (BRU button presses can also be monitored in a text editor such as Word Pad.)

When remapping the BRU buttons to keys, it is important to note that modifier keys such as Shift and Caps Lock keys are ignored. This means, for example, that you cannot remap the BRU unit to the "Y" key within Celeritas Monitor, but you may remap it to the "y" key. Since the BRU acts as a HID keyboard, the Celeritas Monitor application simply sends the key code that is associated with the BRU button. You must be aware, however, that the modifier keys may affect how an application processes the character key that Celeritas Monitor supplies.

**Goal:**
This introduction to Celeritas Monitor acquaints you with how to edit key and Trigger mappings, save and load Front Panel profiles. It also teaches you to understand the diagnostic information Celeritas Monitor provides.

**Overview of Tasks:**
- Open the Celeritas Monitor Software and examine the Acting profile.
- Change the Celeritas BRU mappings.
- Edit the Joystick key mappings, and save the changes made to the Celeritas Device.

**Estimated Time:** 15 minutes
Chapter 7: **Software Interface and Operation**

**Celeritas Monitor, Task 1: Open the Celeritas Monitor Application**

Connect a Celeritas BRU to the Celeritas Console and power it on. Locate the Celeritas Monitor icon in the Start > Programs > Celeritas menu and select it to launch the application. Connect a Celeritas BRU to the Right Fiber Input and a Celeritas Joystick to the Left Fiber Input on the back of the Celeritas Console.

The Celeritas Monitor software is installed as part of the standard Celeritas System software installation. This application is used to create, modify and test key mappings and Front Panel profiles. To open the Celeritas Monitor software, navigate to the appropriate folder and select the Celeritas Monitor shortcut.

1) **Click** on the Windows Start menu, **select** All Programs, and then **select** the Celeritas folder. From the menu, **click** on Celeritas Monitor to **launch** the application.

2) The Celeritas Monitor interface displays a Celeritas Joystick connected to the left fiber input and a Celeritas BRU connected to the right fiber input. All of the detected fibers are depicted as blue buttons. Note the button and trigger mappings on the display.

3) If you have a Celeritas Joystick **connected**, **move** the Celeritas Joystick analog stick. Note the “+” by the Celeritas Joystick image **move** with the motion of the Celeritas Joystick analog stick.

4) On the Celeritas BRU image, **mouse over** the keys and **note** how the buttons change color to light blue and also the corresponding **green light** beneath it. This **indicates** the area is **active**.
Chapter 7: **Software Interface and Operation**

**Celeritas Monitor, Task 2: Use the Celeritas Monitor software to change button and key mappings**

In the Celeritas Monitor interface, click one of the locks, highlight a button and type the desired key mapping.

The Celeritas Monitor’s use of a graphical representation of the Celeritas BRU devices makes changing the button and trigger mappings a simple process. However, note the following before you begin. To alter the current profile, first click one of the locks in Celeritas Monitor interface to put Celeritas Monitor into Edit Mode. Once this occurs, regardless of your connection, you will see the image of two Celeritas BRU Response Devices. This is because the Celeritas Joystick mapping cannot be changed in HID Mode. Also, notice that the default key mappings have appeared under the Celeritas BRU images. To change a mapping, click the mapping and type a new mapping from the keyboard. For more information about default key mappings see Section 6.2.3 Trigger Indicator and Mask, Page 40 and Section 6.4 Celeritas BRU, Page 47.

1) **Click** any lock in the Celeritas Monitor interface to **enable editing**. Two Celeritas BRUs are displayed because the Celeritas Joystick mapping cannot be changed using HID Mode.

**NOTE:** If a Joystick is connected on the left, then only the left pinky is red because the Celeritas Joystick only has four buttons. Otherwise, all five buttons on the left BRU are red because no buttons are detected on the left.

2) **Click** the key mapping under the Celeritas BRU image that you wish to change.

3) **Type** the character you wish to **map** to that button. This example uses a ‘y’.

4) **Click** the silver down arrow next to the lock in the upper right corner of the Celeritas Monitor interface (next to the square wave symbol). **Click** in the text field that reads Equals.

5) **Press** the Space Bar. Notice the text next to Trigger Mapping has **changed** from Equals to Space.
Chapter 7: Software Interface and Operation

Celeritas Monitor, Task 3: Save to Front Panel Profile
Save the new mappings in a profile.

There are several ways to save the state of the Celeritas Console using the Celeritas Monitor software. It is possible to save and export .xml files via the File menu. This option allows .xml files to be loaded using File > Import. To save the current state of the box to the Acting profile, select (File > Save to Acting). The Acting profile mappings shown in the Celeritas Monitor software will persist after the software is closed. However, once the power to the Celeritas Console is shut off, the settings will be lost unless saved to an .xml file or Front Panel profile. Ten Front Panel profiles are available for saving. The first Front Panel profile is the Administrator profile which is loaded into the Acting profile when Celeritas is powered on. The Front Panel profiles are stored on the Celeritas Console allowing custom mappings to be loaded for response collection without using Celeritas Monitor. For more information about default key mappings and loading Front Panel profiles see Section 6.2.2 Left and Right Buttons and Indicators, Page 39.

NOTE: To enable Save to Acting, a Celeritas Console must be connected to the Celeritas Monitor software.

1) Click the lock in the upper right corner of the Celeritas Monitor interface (next to the square wave symbol).

2) Click File > Save to Acting. This will export your mappings to the Acting Front Panel profile. You can test that the mappings were saved using the Section 5.3 Celeritas BRU Quick Functionality Test, Page 35.
Chapter 7: **Software Interface and Operation**

**Celeritas Monitor, Task 4: About the Lock Icons and Diagnostics**

*Click the lock to lock the mappings. Understand the red buttons.*

The Celeritas Monitor interface displays information about the state of the Celeritas Console. The button mappings are displayed along with the state of the buttons. When a button is red, it indicates the Celeritas Console cannot detect the fiber switch. This occurs when either no button is connected or there is a bad fiber or bad fiber connection. There are three lock icons on the Celeritas Monitor interface. Clicking any of them will unlock or lock all of them. When the locks are open, the electrical switch debounce, button and trigger mappings can be edited. If changes are made to the Acting profile, and the lock is closed without saving those changes, a dialog will prompt you with the following three options:

1. **Commit to Acting and Lock:** *Changes are saved to the Celeritas Console, but will be lost when it is powered off.*
2. **Forget changes and Lock:** *Changes are lost and settings from before unlocking are restored.*
3. **Stay Unlocked and continue editing:** *No change, remain in edit mode.*

1) Notice the **left pinky button** on the representation of the Celeritas BRU is **colored red**. When the Celeritas cannot get a signal from a button it will show up red in the Celeritas Monitor interface. In this case the button is red because the Celeritas Joystick is connected. The Celeritas Joystick only has four buttons, and the Celeritas Joystick button mappings cannot be changed in HID Mode.

2) **Change** the right middle finger button to f. Then **click one** of the **lock icons**. This will **open a dialog** prompting the user to **choose one** of **three options**.

3) **Choose Forget changes and Lock.**

4) The original **Acting profile** will now be **loaded**.
Chapter 7: **Software Interface and Operation**

7.3 Celeritas Device in E-Prime 2.0
7.3.1 Tutorial 1: Add a Celeritas BRU to an E-Prime 2.0 Experiment

**Summary:**
The following tutorial teaches you how to configure an existing E-Prime 2.0 experiment to operate with the Celeritas System hardware. We recommend using the Celeritas Device from within E-Prime 2.0 to optimize response collection. Adding the Celeritas Device to the Experiment Object and configuring it to emulate the Keyboard Device gives you the flexibility to test your experiment when you do not have access to the Celeritas System.

Before continuing with the tutorial, it is important that you understand how the task works. The task itself is simple; one of two letters, an “X” or “Y,” is presented on the screen. The appropriate keyboard responses are “1” and “2” respectively. Once the response is collected and scored, the feedback is presented.

This tutorial is set up to work with a keyboard and one Celeritas BRU configured to emulate a keyboard. This configuration allows you to program and test your experiment using a keyboard. When running with the Celeritas System, you can use either the BRU or the keyboard to make your responses. This tutorial assumes that you have the Celeritas System software installed and one Celeritas BRU connected to the Right Fiber Input.

**Goal:**
This tutorial illustrates how to add the Celeritas Device into the BasicRT.es2 sample experiment included with E-Prime 2.0 installation. When you have completed the tutorial, you will know how to change and save key mappings within an E-Prime 2.0 experiment and you will be able to test your experiment with and without Celeritas System hardware.

**Overview of Tasks:**
- Open the BasicRT.es2 and save it as CeleritasBasicRT.es2.
- Add the Celeritas Device to CeleritasBasicRT.es2.
- Edit the Celeritas Device to emulate the Keyboard Device.
- Edit and then save the BRU key mappings.
- Edit the Instructions slide.
- Run the CeleritasBasicRT.es2 and respond with either the Celeritas BRU or the keyboard.

**Estimated Time:** 15 minutes
Chapter 7: **Software Interface and Operation**

**Tutorial 1, Task 1: Open BasicRT.es2, Save, and Open the Device Properties**

Load the BasicRT.es2 sample experiment, save it as CeleritasBasicRT.es2 and open the Experiment Object Properties dialog.

The E-Studio application is installed as part of the typical E-Prime 2.0 installation. This application is used to create, modify and test experiments within E-Prime 2.0. It can be opened via the Start Menu, or by double clicking an .es2 file. To open BasicRT.es2, navigate to ...My Experiments\Samples\BasicRT\BasicRT.es2 and double click the file. If the ...My Experiments folder does not exist in E-Studio go to Tools > Options > General >Samples and Tutorials. Click Copy Samples and Tutorials to My Experiments Folder... . Use F12 to save the experiment as CeleritasBasicRT.es2 and open the Experiment Object Properties dialog.

1) **Navigate** to ...My Experiments\Samples\BasicRT, and **double click** the BasicRT.es2 file. **Select** Maintain the E-Prime 2.0 Standard file format, and **click OK**.

2) **Press F12**, and **save** the experiment as CeleritasBasicRT.es2. **Click Save**.

3) **Double click** the Experiment Object at the **top** of the tree in the **Structure** window. **Click** on the **Devices** tab of the Experiment Object Properties dialog.
Tutorial 1, Task 2: Add and Open the Celeritas Device

Add the Celeritas Device to the experiment and open the Celeritas Device Properties.

The Celeritas Device needs to be added to the Experiment Object. Once this is complete, double click the device to open it for editing.

1) Click the Add... button.

2) Double click the Celeritas Device to add it to the devices.

3) The Celeritas Device is now listed among the available devices. Double click the Celeritas Device to edit the Device properties.
Chapter 7: **Software Interface and Operation**

**Tutorial 1, Task 3: Configure the Celeritas Device**

*Configure the Celeritas BRU to emulate the Keyboard Device.*

The Celeritas Device Properties presents two dropdown boxes above the illustration of the device mappings. The first indicates which type of hardware is available to connect, and the state of the hardware (connected/disconnected). To the left of this control there is another dropdown box which reads E-Prime. This dropdown box allows you to set the collection mode for the connected device (Presses Only, Releases Only, Presses and Releases), and which device to emulate. For this tutorial, we emulate the keyboard. In order to make changes to the default configuration, one of the three locks must be unlocked; unlocking one will unlock all three.

1) **Locate one** of the three lock buttons, and **click** it.

2) **Click** the E-Prime dropdown. **Select** Keyboard. **Click** the E-Prime dropdown to **close** it. **NOTE:** *If you chose not to emulate the keyboard in this experiment and you wish to use the Celeritas System for response collection, you must add a Celeritas Input Mask to any response collection object, or you will need to add additional input masks to your response collection objects to test the experiment.*
Chapter 7: Software Interface and Operation

Tutorial 1, Task 4: Edit the Key Mappings
Edit the key mappings so the index finger is “1” and the middle finger is “2”.

The default BRU key mappings are displayed in the interface. The index finger is mapped to “1” and the middle to “2”. We also re-map the thumb key to be a “3” in order to have a unique response for each button. Since the lock is still open, the configuration is still editable. Remember the new key mappings created in this task are saved as part of the experiment specification file (.es2), and are only in effect when the experiment is running.

1) **Click** the index finger button. Notice how the button changes color, the “2” above the button becomes bold, the “2” in the box below is highlighted and the green light above the “2” on the front panel representation is also bold.

2) **Press** the “1” key on the keyboard.

3) **Click** the middle finger button, and **press** the “2” key.

4) **Edit** the thumb button to be three.

5) **Click** the lock to close it. **Click OK** to dismiss the Celeritas Device dialog, and **click OK** to dismiss the Experiment Object Properties.
Chapter 7: **Software Interface and Operation**

**Tutorial 1, Task 5: Edit the Instructions**

*Edit the instructions slide. Direct the participant to use the index and middle fingers.*

Before you run the experiment, you need to edit the instructions to reflect the changes made in the mappings so that the participant uses the correct fingers to respond to the cues. The index finger will be mapped to “1” and the middle to “2”.

1) **Double click** the **Instructions** in the **Structure** window of the experiment.

2) **Click** in the **Instructions** to **edit** the sentence: “Press ‘1’ for an ‘X’ or ‘2’ for a ‘Y’.”

3) **Confirm** that the sentence reads: “Press your index finger for an ‘X’ or your middle finger for a ‘Y’.”
Chapter 7: **Software Interface and Operation**

**Tutorial 1, Task 6: Run the Experiment**
*Run the experiment, using either the Celeritas BRU or keyboard to respond.*

The next steps walk you through generating the experiment script, launching the experiment, and running the experiment.

1) **Press Ctrl+S** to save your work before continuing. **Click the generate icon** or **press Ctrl+F7** to generate the script and **check it for errors**.

2) **Click the run icon** or **press F7** to **run** the paradigm.

3) **Click OK** to accept the **default values** for **Subject Number**, **Session Number** and **Summary of Startup Info**.

4) **Use the Celeritas BRU and/or keyboard to complete the experiment.**
Chapter 7: **Software Interface and Operation**

### 7.3 Celeritas Device in E-Prime 2.0
#### 7.3.2 Tutorial 2: Add a Celeritas Joystick to an E-Prime 2.0 Experiment

**Summary:**
The following tutorial teaches you how to configure an existing E-Prime 2.0 experiment to operate with the Celeritas System hardware. We recommend using the Celeritas Device from within E-Prime 2.0 to optimize response collection. Adding the Celeritas Device to the Experiment Object and configuring it to emulate the Keyboard Device gives you the flexibility to test your experiment when you do not have access to the Celeritas System.

Before continuing with the tutorial, it is important that you understand how the task works. The task itself is simple; one of two letters, an “X” or “Y,” is presented on the screen. The appropriate keyboard responses are “1” and “2” respectively. Once the response is collected and scored, the feedback is presented.

This tutorial is set up to work with a keyboard and one Celeritas Joystick configured to emulate a keyboard. This configuration allows you to program and test your experiment using a keyboard. When running with the Celeritas System, you can use either the Joystick or the keyboard to make your responses. This tutorial assumes that you have the Celeritas System software installed and one Celeritas Joystick connected to the Right Fiber Input.

**Goal:**
This tutorial illustrates how to add the Celeritas Device into the BasicRT.es2 sample experiment included with E-Prime 2.0 installation. When you have completed the tutorial, you will know how to change and save key mappings within an E-Prime 2.0 experiment and you will be able to test your experiment with and without Celeritas System hardware.

**Overview of Tasks:**
- Open the BasicRT.es2 and save it as CeleritasBasicRT.es2.
- Add the Celeritas Device to CeleritasBasicRT.es2.
- Edit the Celeritas Device to emulate the Keyboard Device.
- Edit and then save the Joystick key mappings.
- Edit the Instructions slide.
- Run the CeleritasBasicRT.es2 and respond with either the Celeritas Joystick or the keyboard.

**Estimated Time:** 15 minutes
Chapter 7: **Software Interface and Operation**

**Tutorial 2, Task 1: Open BasicRT.es2, Save, and Open the Device Properties**

Load the BasicRT.es2 sample experiment, save it as CeleritasBasicRT.es2 and open the Experiment Object Properties dialog.

The E-Studio application is installed as part of the typical E-Prime 2.0 installation. This application is used to create, modify and test experiments within E-Prime 2.0. It can be opened via the Start Menu, or by double clicking an .es2 file. To open BasicRT.es2, navigate to ...My Experiments\Samples\BasicRT\BasicRT.es2 and double click the file. If the ...My Experiments folder does not exist in E-Studio go to Tools > Options > General >Samples and Tutorials. Click Copy Samples and Tutorials to My Experiments Folder... . Use F12 to save the experiment as CeleritasBasicRT.es2 and open the Experiment Object Properties dialog.

1) **Navigate** to ...My Experiments\Samples\BasicRT, and **double click** the BasicRT.es2 file. **Select** Maintain the E-Prime 2.0 Standard file format, and **click OK**.

2) **Press F12**, and **save** the experiment as CeleritasBasicRT.es2. **Click Save**.

3) **Double click** the Experiment Object at the top of the tree in the Structure window. **Click** on the Devices tab of the Experiment Object Properties dialog.
Chapter 7: **Software Interface and Operation**

**Tutorial 2, Task 2: Add and Open the Celeritas Device**

*Add the Celeritas Device to the experiment and open the Celeritas Device Properties.*

The Celeritas Device needs to be added to the Experiment Object. Once this is complete, double click the device to open it for editing.

1) **Click** the Add... button.

2) **Double click** the Celeritas Device to *add* it to the devices.

3) The Celeritas Device is now listed among the available devices. **Double click** the Celeritas Device to *edit* the Device properties.
Chapter 7: Software Interface and Operation

Tutorial 2, Task 3: Configure the Celeritas Device
Configure the Celeritas Joystick to emulate the Keyboard Device.

The Celeritas Device Properties presents two dropdown boxes above the illustration of the device mappings. The first indicates which type of hardware is available to connect, and the state of the hardware (connected/disconnected). To the left of this control there is another dropdown box which reads E-Prime. This dropdown box allows you to set the collection mode for the connected device (Presses Only, Releases Only, Presses and Releases), and which device to emulate. For this tutorial, we emulate the keyboard. In order to make changes to the default configuration, one of the three locks must be unlocked; unlocking one will unlock all three.

1) **Select** the Celeritas Joystick from the dropdown box. **Locate one of the three lock buttons**, and **click** it.

2) **Click** the E-Prime dropdown. **Select** Keyboard. **Click** the E-Prime dropdown to **close** it. **NOTE:** If you chose not to emulate the keyboard in this experiment and you wish to use the Celeritas System for response collection, you must add a Celeritas Input Mask to any response collection object, or you will need to add additional input masks to your response collection objects to test the experiment.
Chapter 7: **Software Interface and Operation**

**Tutorial 2, Task 4: Edit the Key Mappings**

*Edit the key mappings so the index finger is “1” and the middle finger is “2”.*

The default Celeritas Joystick key mappings are displayed in the interface. Since the experiment is set up to use “1” and “2” as the allowable responses, you will edit the key mappings to something more logical. You will use the two back buttons to make responses. The top button on the back of the Joystick (index finger) is mapped to “1”; the bottom button on the back of the Joystick (middle finger) is mapped to “2”. We also re-map the two top buttons on the Joystick to be a “3” and “4” in order to have a unique response for each button. Since the lock is still open, the configuration is still editable. Remember that the new key mappings created in this task are saved as part of the experiment specification file (.es2), and are only in effect when the experiment is running.

1) **Click** the back, top button on the **Celeritas Joystick** in the interface. Notice how the button changes color, the three above the button becomes bold, the three in the box below is highlighted and the green light above the three on the front panel representation is also bold.

2) **Press** the “1” key on the keyboard.

3) **Click** the bottom button, on the back of the **Celeritas Joystick** and **press** the “2” key on the keyboard.

4) **Edit** the buttons to the right and left of the analog stick to be “3” and “4”. **Click** the lock to **close** it. **Click** OK to **dismiss** the Celeritas Device dialog, and **click** OK to **dismiss** the Experiment Object Properties.
Tutorial 2, Task 5: Edit the Instructions

Edit the instructions slide. Direct the participant to use the index and middle fingers.

Before you run the experiment, you need to edit the instructions to reflect the changes made in the mappings so that the participant uses the correct fingers to respond to the cues. The index finger will be mapped to “1” and the middle to “2”.

1) **Double click** the Instructions in the Structure window of the experiment.

2) **Click** in the Instructions to **edit** the sentence: “Press ‘1’ for an ‘X’ or ‘2’ for a ‘Y’.”

3) **Confirm** that the sentence **reads**: “Press your index finger for an ‘X’ or your middle finger for a ‘Y’.”
Chapter 7: Software Interface and Operation

Tutorial 2, Task 6: Run the Experiment

*Run the experiment, using either the Celeritas BRU or keyboard to respond.*

The next steps walk you through generating the experiment script, launching the experiment, and running the experiment.

1) **Press Ctrl+S** to save your work before continuing. *Click* the generate icon or **press Ctrl+F7** to generate the script and **check** it for **errors**.

2) **Click** the run icon or **press F7** to **run** the paradigm.

3) **Click OK** to accept the default values for **Subject Number**, **Session Number** and **Summary of Startup Info**.

4) **Use** the Celeritas BRU and/or keyboard to **complete** the experiment.
Chapter 7: **Software Interface and Operation**

7.3 Celeritas Device in E-Prime 2.0

7.3.3 Tutorial 3: Explore a Celeritas-enabled E-Prime 2.0 Joystick experiment

**Summary:**
The following tutorial illustrates how to use the Celeritas Device in an E-Prime 2.0 experiment. The experiment provided is complete and functions out of the box with the Celeritas System or with a standard desktop joystick (after the Celeritas Device has been unchecked). This tutorial will use E-Basic script to determine where the cursor is on-screen. You will still have the flexibility to test your experiment with the Celeritas Device disabled – using any standard desktop joystick to make responses.

Before continuing with the tutorial, it is important that you understand how the task works. When the task begins, you will see a fixation followed by a slide with four boxes on it. Also on this slide are directions instructing the participant to move the cursor to a numbered box and press a button once the cursor is in the box. When you move the cursor into the box number indicated by the directions, the box turns green. Conversely, when you move the cursor into a box not indicated by the directions, the box turns red. Once the selection has been made, the trial is over and the next begins. There are four trials.

This tutorial is set up to work with one Celeritas Joystick, or a standard desktop joystick. Before you begin, install the Celeritas System software and driver from the CD that came with your Celeritas System. Plug the Celeritas Joystick into the right fiber optic input in the Celeritas Console, and connect the Celeritas Console to the stimulus presentation computer. See Section 4.2 Software Installation, Page 20 for more information. Initially, if the Celeritas System (Console and BRU) is not connected then you will not be able to edit the Celeritas Device from within E-Prime 2.0.

**Goal:**
This tutorial illustrates how to use a HitTest script using the cursor position. When you have completed the tutorial, you will know how to modify an E-Prime 2.0 experiment to use the Celeritas Joystick or any standard desktop joystick.

**Overview of Tasks:**
- Open the CeleritasJoystickHitTest.es2 experiment.
- Examine the Joystick and Celeritas Devices.
- Examine the ShowJoystickCursor InLine.
- Examine the HitTest InLine.
- Run the CeleritasJoystickHitTest.es2 with and without the Celeritas Device enabled.

**Estimated Time:** 15 minutes
Chapter 7: **Software Interface and Operation**

**Tutorial 3, Task 1: Open CeleritasJoystickHitTest.es2, and Open the Device Properties**

Load the CeleritasJoystickHitTest.es2 and open the Experiment Object Properties dialog.

To open CeleritasJoystickHitTest.es2, navigate to ...\My Experiments\Celeritas\Tutorials\CeleritasJoystickHitTest\CeleritasJoystickHitTest.es2 and double click the file. If the ...\My Experiments folder does not exist in E-Studio go to Tools > Options > General > Samples and Tutorials. Click Copy Samples and Tutorials to My Experiments Folder...

1) **Navigate** to ...\My Experiments\Celeritas\Tutorials\CeleritasJoystickHitTest, and **double click** the CeleritasJoystickHitTest.es2 file.

2) If prompted to convert to **Professional**, **choose no**. **Select** Maintain the E-Prime 2.0 Standard file format, and **click OK**.

3) **Double click** the **Experiment Object** at the top of the tree in the **Structure** window. **Click** on the **Devices** tab of the **Experiment Object Properties** dialog.
Chapter 7: **Software Interface and Operation**

**Tutorial 3, Task 2: Examine and Understand the Celeritas and Joystick Devices**

*Open the Experiment Object Properties dialog and look at the settings.*

The Experiment Object Properties dialog list the Devices necessary for the experiment to run. Upon opening the Celeritas Device you see that it is connected and in the default configuration; no emulation. Under the Edit menu, two properties have been initiated for the Celeritas Device to use, the ShowCursor and the AttachToMouseCursor properties. These properties are necessary if you wish to use the Celeritas Joystick as a pointing device during an experiment. The ShowCursor property makes the cursor visible to the participant and the AttachToMouseCursor property allows the Celeritas analog stick to move the mouse cursor during an experiment. The Joystick Device is also listed in the devices and is necessary for the ability to run the experiment without the Celeritas Joystick. A standard desktop joystick can be used as a Response Device after the Celeritas Device is unchecked.

1) **Double click** the Celeritas Device to examine the Device properties.

2) **Observe** the Celeritas Joystick is connected.

3) The Emulate Device Property is set to (none).

4) **Click Edit. Notice** the Show Cursor? and Attach to Mouse Cursor? properties are checked. **Click OK** to close the Celeritas Device.

5) **Notice** the Joystick Device is listed among the Devices. This allows the experiment to run without the Celeritas Device enabled.

6) **Click OK** to close the Experiment Object Property Pages.
Chapter 7: Software Interface and Operation

Tutorial 3, Task 3: Examine the ShowJoystickCursor InLine

Open the ShowJoystickCursor InLine and examine the script.

The ShowJoystickCursor InLine is one of the modifications needed to make the experiment function without the Celeritas System. Here the ShowCursor and AttachToMouseCursor are used with the Joystick Device via script. The result is the same as it was for the Celeritas Device. The ShowCursor property allows the cursor to be visible to the participant and the AttachToMouseCursor property allows the standard desktop joystick to move the Joystick axes during an experiment.

1) **Double click** the ShowJoystickCursor InLine to open it in the workspace.

2) This looks to see if the Celeritas Device is closed. **NOTE:** A device state is closed when the device is unchecked in the Experiment Object Properties.

   (line 2)

3) If the Celeritas Device is closed, the cursor movement is **bound** to the Joystick Device.

   (line 4)

4) If the Celeritas Device is closed, the Joystick cursor movement is **visible**.

   (line 6)
Chapter 7: **Software Interface and Operation**

**Tutorial 3, Task 4: Examine the HitTest InLine**

*Double click the HitTest InLine to open and examine the contents.*

The HitTest InLine performs many functions. This step of the tutorial will walk you through those functions. One of the first functions of the HitTest InLine is to determine the coordinates of the cursor on-screen.

1) **Double click** the HitTest InLine to **open** it in the workplace.

2) **Variable declarations.**
   (lines 1-5)

3) **Initialize Loop** variables.
   (lines 7-8)  
   **Beginning** of Loop.
   (line 10)

4) **Check** to see if Celeritas Device is open.
   (line 12)

5) **Get cursor coordinates.**
   (line 13-16)
Chapter 7: Software Interface and Operation

Tutorial 3, Task 4 (continued): Examine the HitTest InLine

Continue to examine the contents of the HitTest InLine.

Next the HitTest InLine does a comparison to see if the current cursor coordinates fall into one of the areas on screen that you care about, an area of interest (AOI), in this case one of the blue boxes. After that, the box color changes to red (incorrect box) or green (correct box) reflecting the accuracy of the choice.

6) **Check** to see if the cursor **falls** in AOI.
   (line 18-19)

7) **Check** to see if the cursor position has **changed**.
   (line 20)

8) **Change** box colors.
   (line 28-38)
Chapter 7: **Software Interface and Operation**

**Tutorial 3, Task 4 (continued): Examine the HitTest InLine**

*Continue to examine the contents of the HitTest InLine.*

Finally, the HitTest InLine checks for a button press, and if a response has occurred, it sends the response to the Mouse Device to score the response, and then exits the loop.

9) **Check** if a **button press occurred** while the **cursor** was **over** one of the **boxes**.
   (line 46)

10) **Assign** accuracy.
    (line 50-55)

11) **Exit Loop.**
    (line 59)
Chapter 7: Software Interface and Operation

Tutorial 3, Task 5: Run the Experiment twice
Run the experiment with the Celeritas Device enabled to verify that the Celeritas Device is working, and run it again with the Celeritas Device disabled.

The next steps walk you through generating the experiment script, starting the experiment, and running the experiment with and without the Celeritas Device enabled. To run the experiment without the Celeritas Device enabled, all you have to do is uncheck the Celeritas Device in the Experiment Object Properties. When you uncheck the Celeritas Device, the device will appear as “closed” when the experiment is run. When the Celeritas Device is closed, the Celeritas System will operate in HID Mode and the Celeritas Joystick will appear to E-Prime as a standard desktop joystick. Recall that when operating as a HID Joystick, the Joystick buttons cannot be remapped. You will be in HID Mode. If you are using the Celeritas Joystick, remember the Joystick buttons cannot be remapped in HID Mode; you will need to use the two buttons next to the analog stick. If you are using a standard desktop Joystick, you will need to determine which buttons on that Joystick are mapped to “1” and “2”.

1) Press **Ctrl+S** to save your work before continuing. Click the **generate icon** or press **Ctrl+F7** to generate the script and check it for errors.

2) Click the **run icon** or press **F7** to run the paradigm.

3) Click **OK** to accept the default values for Subject Number, Session Number and Summary of Startup Info.

4) Use the Celeritas Joystick to **complete** the experiment.

5) After the experiment has finished, double click the Experiment Object at the top of the tree in the Structure window. Click on the Devices tab of the Experiment Object Properties dialog. Uncheck the Celeritas Device, and follow steps 1-3 above, or a standard desktop joystick to respond to the experiment.
Chapter 7: Software Interface and Operation

7.4 Celeritas E-Prime 2.0 Samples

The Celeritas System software installation includes three sample experiments that illustrate various ways to implement different functionality using the Celeritas Joystick Device from within E-Prime 2.0. These samples should be used as a guide from which to build experiments that are more complex.

Celeritas BRU Button Task
The CeleritasBRUButtonTask.es2 is implemented as an E-Prime 2.0 Standard experiment. It shows the application of the Celeritas BRUs in an E-Prime 2.0 task. The default setup of the CeleritasBRUButtonTask.es2 allows for the immediate use of the experiment with a BRU attached to the left and right connections on the Celeritas Console. The task begins by presenting a fixation cross for two seconds. This is followed by an image of two hands in which one of the fingers will be highlighted by a red box. To complete the task, press the button on the BRU under the highlighted finger. After responding, you are shown response time and accuracy feedback related to your response. The task has ten trials, and concludes with a good-bye screen.

The Celeritas Device is set to emulate keyboard responses, so the Input Mask on the Stimulus object does not need to be changed when the Celeritas hardware is disconnected.

Celeritas Joystick Rating Task
The CeleritasJoystickRatingTask.es2 is implemented as an E-Prime 2.0 Professional experiment. This sample allows for the use of the Celeritas Joystick or any standard desktop joystick as a Response Device because it uses emulation; see Section 7.3 Celeritas Device in E-Prime 2.0, Page 62. It demonstrates the ability to use E-Prime 2.0 in conjunction with the Celeritas Joystick to use slider and scale functionality in E-Prime 2.0. The first part of the experiment, the Discrete Slider portion, displays the positive X and Y axes of a rating scale. The instructions direct you to move the Joystick analog stick to select any number. Once you have selected the number, a button press ends this portion of the experiment. The DiscreteSliderProc Procedure implements a discrete slider by displaying it with the SliderStimulus object and processing responses using script located inside the IsPending() method loop in the SliderProcessResponses InLine object.

The Likert scale portion of the experiment, displays a Likert rating scale. The directions prompt you to use the Joystick analog stick to select an option on the scale, and then press a button to choose that option. The LikertScaleProc Procedure implements three different versions of a five-point Likert Scale by displaying the scale with the ScaleStimulus object and processing responses to it using script located inside the IsPending() method loop in the ScaleProcessResponses InLine object.

Celeritas Joystick RT
The CeleritasJoystickRT.es2 is implemented as an E-Prime 2.0 Professional experiment. This sample is a simple reaction time experiment, which demonstrates how to emulate button responses from a Celeritas Joystick so that a Joystick Input Mask will detect them.

Celeritas Joystick Hit Test
The CeleritasJoystickHitTest.es2 is implemented as an E-Prime Standard experiment. This sample demonstrates how to use the Celeritas Joystick device to visually navigate to and select target stimuli on screen.
Chapter 8: Specifications

8.1 External I/O Connector

External I/O Connector: The external I/O connector provides the Celeritas System user with the ability to control external devices as well as receive inputs from external devices. The external I/O connector consists of ten TTL compatible output pins. The connector provides ten inputs (one for each button) allowing the user to trigger the Celeritas buttons from external devices. The TTL inputs are logically or'd with the Celeritas buttons and will trigger its corresponding button on a rising edge (zero to 5V) of the input signal. The connector also contains a current limited +5V power pin, which the user can utilize to power low current devices or custom circuits. The unit is internally limited to 500mA. Each External Input has a programmable debounce period which can be configured through the Celeritas Monitor application (in HID Mode), or through the Celeritas Device Properties (in E-Prime).
Chapter 8: Specifications

8.1.1 Pinout

<table>
<thead>
<tr>
<th>PIN NUMBER</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Button 1 Output</td>
</tr>
<tr>
<td>2</td>
<td>Button 2 Output</td>
</tr>
<tr>
<td>3</td>
<td>Button 3 Output</td>
</tr>
<tr>
<td>4</td>
<td>Button 4 Output</td>
</tr>
<tr>
<td>5</td>
<td>Button 5 Output</td>
</tr>
<tr>
<td>6</td>
<td>Button 6 Output</td>
</tr>
<tr>
<td>7</td>
<td>Button 7 Output</td>
</tr>
<tr>
<td>8</td>
<td>Button 8 Output</td>
</tr>
<tr>
<td>9</td>
<td>Button 9 Output</td>
</tr>
<tr>
<td>10</td>
<td>Button 10/A Output</td>
</tr>
<tr>
<td>11</td>
<td>Trigger Pulse Output</td>
</tr>
<tr>
<td>12</td>
<td>Ground</td>
</tr>
<tr>
<td>13</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Button 1 Input</td>
</tr>
<tr>
<td>15</td>
<td>Button 2 Input</td>
</tr>
<tr>
<td>16</td>
<td>Button 3 Input</td>
</tr>
<tr>
<td>17</td>
<td>Button 4 Input</td>
</tr>
<tr>
<td>18</td>
<td>Button 5 Input</td>
</tr>
<tr>
<td>19</td>
<td>Button 6 Input</td>
</tr>
<tr>
<td>20</td>
<td>Button 7 Input</td>
</tr>
<tr>
<td>21</td>
<td>Button 8 Input</td>
</tr>
<tr>
<td>22</td>
<td>Button 9 Input</td>
</tr>
<tr>
<td>23</td>
<td>Button 10/A Input</td>
</tr>
<tr>
<td>24</td>
<td>5V (500 mA max.)</td>
</tr>
<tr>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>
Chapter 8: Specifications

8.1.2 External Button Input Timing Requirements

<table>
<thead>
<tr>
<th>Mode</th>
<th>Th</th>
<th>Ti</th>
<th>Tp</th>
</tr>
</thead>
<tbody>
<tr>
<td>HID</td>
<td>1 ms</td>
<td>1 ms</td>
<td>2 ms</td>
</tr>
<tr>
<td>Celeritas</td>
<td>100 μs</td>
<td>100 μs</td>
<td>200 μs</td>
</tr>
</tbody>
</table>

Th (Minimum High Pulse Width) is the minimum amount of time the input signal or button must stay high or “pressed” (e.g. above 2V). High pulses shorter than Th will prevent these pulses from being detected.

Tl (Minimum Low Pulse Width) is the minimum amount of time the input signal or button must stay low or “released” before the next signal event occurs. (e.g. below 0.8V). Low pulses shorter than Tl will prevent these pulses from being detected.

Tp (Minimum Pulse Period) is the minimum amount of time between two consecutive pulses or button presses. Pulse periods less than Tp, may prevent some pulses from being detected.

NOTE: The Trigger Input pulse has a minimum Th and Tl of 2 μs

8.1.3 About the External Trigger Pulse Output

Not all scanners supply an external trigger signal, check with your manufacturer for compatibility.

To accommodate a wide range of incoming trigger durations (and ensure that an extremely short pulse is not missed) the console circuitry generates its own internal pulse based upon the rising edge of the incoming trigger. The console extends this pulse for 10 ms. This modified trigger pulse is supplied to the user on pin 11 of the consoles External I/O Connector.

NOTE: The expanded use of these connectors should be accessed by qualified Electronics Technicians.
# Chapter 8: Specifications

## 8.2 Component Specifications

<table>
<thead>
<tr>
<th><strong>Console</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>11.42&quot; x 10.24&quot; x 2.91&quot; (29cm x 26cm x 7.4cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>3 lbs (1.4 kg)</td>
</tr>
<tr>
<td>Input Voltage</td>
<td>9V</td>
</tr>
<tr>
<td>Max Current</td>
<td>800 mA</td>
</tr>
<tr>
<td>Material</td>
<td>ABS plastic (Flammability UL 94V-0)</td>
</tr>
<tr>
<td>Sampling Rate</td>
<td>20 kHz per fiber</td>
</tr>
<tr>
<td>Connectivity</td>
<td>USB 2.0 Full Speed only 5V BNC for Electrical Trigger Input VersatileLink for Optical Trigger Input DB25 External I/O Expansion Port Two 10-fiber Push-Pull Response Device Connectors</td>
</tr>
<tr>
<td>Supported Response Devices</td>
<td>Button Response Unit (BRU) Joystick</td>
</tr>
<tr>
<td>HID Response Interval</td>
<td>1000 Hz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Button Response Unit (BRU)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size (min)</strong></td>
<td>13&quot; x 5&quot; x 2.25&quot; (33cm x 12.7cm x 5.7cm)</td>
</tr>
<tr>
<td><strong>Size (max)</strong></td>
<td>14&quot; x 5.13&quot; x 2.25&quot; (35.6cm x 13cm x 5.7cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>1.5 lbs (0.7 kg)</td>
</tr>
<tr>
<td>MRI Safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Fiber Cable Length</td>
<td>13 feet (4 m)</td>
</tr>
<tr>
<td>Fiber Bend Radius</td>
<td>2 inches (5.08 cm)</td>
</tr>
<tr>
<td>Materials</td>
<td>Kydex, silicone, Velcro, Plasticized PVC</td>
</tr>
<tr>
<td>Button Click Audible</td>
<td>Yes</td>
</tr>
<tr>
<td>Expected Lifetime</td>
<td>1 million actuations</td>
</tr>
<tr>
<td>Number of buttons</td>
<td>2, 3, or 5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Joystick</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Size</strong></td>
<td>7.5&quot; x 4&quot; x 3.5&quot; (19cm x 10cm x 9cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>1 lb (0.45 kg)</td>
</tr>
<tr>
<td>MRI Safe</td>
<td>Yes</td>
</tr>
<tr>
<td>Fiber Cable Length</td>
<td>13 feet (4 m)</td>
</tr>
<tr>
<td>Fiber Bend Radius</td>
<td>2 inches (5.08 cm)</td>
</tr>
<tr>
<td>Materials</td>
<td>Steralloy, Velcro, Visijet® M3 Black</td>
</tr>
<tr>
<td>Button Click Audible</td>
<td>Yes</td>
</tr>
<tr>
<td>Expected Lifetime</td>
<td>1 million actuations</td>
</tr>
<tr>
<td>Number of buttons</td>
<td>4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Cable</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Length</td>
<td>32.8 feet (10 m)</td>
</tr>
<tr>
<td>Fiber Bend Radius</td>
<td>2 inches (5.08 cm)</td>
</tr>
<tr>
<td>Cable Diameter</td>
<td>0.4 inches (1cm)</td>
</tr>
<tr>
<td>Connector Diameter</td>
<td>0.75 inches (1.9cm)</td>
</tr>
<tr>
<td>Weight</td>
<td>1 lb (0.45 kg)</td>
</tr>
</tbody>
</table>
Chapter 9: HID Mode

HID (Human Interface Device) Mode

Earlier chapters in this document describe the two software options that interact with the Celeritas Response Devices. When configured with the Celeritas Monitor application, the Celeritas Response Devices function as HID Devices. When utilized within E-Prime, the Celeritas hardware functions as a custom E-Prime device. The system requirements presented in Section 2.2 System Requirements, Page 12 describe the software and hardware specifications necessary to support the Celeritas Monitor application for the use of E-Prime.

However, the Celeritas BRU and the Celeritas Joystick can also be used “out-of-the-box”, with no Celeritas System software installation or Response Device configuration, on any computer system that supports a Full Speed USB. Used in this way, the Celeritas Response Devices function as “standalone” HID Devices. Specifically, the Celeritas BRU is seen as a HID keyboard and the Celeritas Joystick functions as a HID joystick.

Without the use of either the Celeritas Monitor application or the Celeritas Device Properties within E-Prime, the Response Devices may not be custom-configured, e.g. you may not re-map any of the buttons to different keys. Still, the Celeritas hardware can be used as a HID Device on any computer system that supports Full Speed USB but which may not support the system requirements for use of Celeritas Monitor or E-Prime, such as those running legacy Windows versions or the Mac OS.

Further, a Celeritas Response Device that is connected to the Celeritas Console has access to any profiles that are stored on the console. The creation of hardware profiles, described in Chapter 7: Software Interface and Operation, Page 55, does require Celeritas Monitor, and therefore access to a computer system that matches the Celeritas System requirements. However, once created and saved to the Celeritas Console, the profiles remain with the console and therefore to any Response Device connected to the console.
## Chapter 10: Troubleshooting Guide

<table>
<thead>
<tr>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
</table>
| Fiber switches are not generating responses on the Front Panel or the Host | • Verify unit has power switch is in the I position and the embedded indicator is illuminated  
• Press the Reset button on the front panel  
• Verify that the fiber switches were detected, by either watching the front panel calibration feedback, or using Celeritas Monitor  
• Trace the fiber cables from the control room into the Scanner Room, using the serial numbers on the connectors, to verify the Response Devices are attached correctly  
• Swap cables and/or Fiber Input ports to determine if the issue affects only a particular cable, Fiber Input port, or Response Device (press Reset after making changes to the fiber cabling)  
• Turn the power switch off, wait three seconds, and then turn it back on  
• Disconnect any devices attached to the External I/O Port |
| Fiber switches generate the wrong response                            | • Verify unit has power switch is in the I position and the embedded indicator is illuminated  
• Press the Reset button on the front panel |
| Receiving unwanted fiber switch responses                            | • Disconnect any devices attached to the External I/O Port |
| Triggers are not generating responses                                | • Verify that the scan sequence generates Trigger pulses  
• Check the Trigger Input connection  
• Verify that only one Trigger Input is connected  
• Turn the Trigger Mask off  
• If using the Electrical Trigger, make sure it is a 5V signal  
• Verify pulse timing meets Celeritas minimum requirements |
| Joystick axes are not generating responses                           | • Configure the software application to use axes X and Y for the Primary Joystick and axes Z and RX for the Secondary Joystick  
• Disconnect all other joysticks or gamepads and restart the application  
• Set Celeritas as the Preferred Device in the Game Controllers Applet |
| Joystick controls the wrong axes                                     | • Verify that the Primary Joy setting is correct  
• Configure the software application to use axes X and Y for the Primary Joystick and axes Z and RX for the Secondary Joystick |
| Joystick axis response indicator illuminates when the Joystick is in the center position | • While the Joystick is in the center position, press the Reset button on the front panel  
• Push the Joystick all the way up, left, down, and right to recalibrate the limits. |
| Joystick must be pushed very far to generate a response              | • If the software application has a configurable dead zone, set it to 0  
• Contact PST Support for assistance to disable the hardware dead zone |
| Application recognizes an Xbox 360 controller, but not Celeritas Joysticks | • Use the open-source application x360ce (Xbox 360 Controller emulator) to make Celeritas appear like an Xbox 360 controller |
| Response Device does not match Front Panel Device Indicator         | • Press the Reset button on the front panel  
• Turn the power switch off, wait three seconds, and then turn it back on |
| Reset does not initiate calibration                                  | • Turn the power switch off, wait three seconds, and then turn it back on |
| HID responses are not being received in HID mode                    | • Turn the power switch off, wait three seconds, and then turn it back on |
| Celeritas Monitor or E-Prime 2.0 cannot find Celeritas              | • Check the USB connection  
• Unplug Celeritas from the USB, wait three seconds, then plug it back in  
• Turn the power switch off, wait three seconds, and then turn it back on  
• Do not click the Safely Remove icon for Celeritas E-Prime  
• Use only Celeritas Monitor or the E-Prime Device GUI, but not both simultaneously |
Chapter 6: Hardware Operation, Page 37 documents the default key and response mappings for the Celeritas Response Devices when used as both as a HID Device and an E-Prime Custom Response Device. With these default mappings, the Response Devices can be used out-of-the box. However, the devices can also be used in other modes or emulate other Response Devices. To do so requires the Celeritas System software.

### Default Mappings, Celeritas Device Properties:

<table>
<thead>
<tr>
<th>Joystick Button</th>
<th>Left Joystick</th>
<th>Right Joystick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Left</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>Top Right</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>Back Top</td>
<td>8</td>
<td>3</td>
</tr>
<tr>
<td>Back Bottom</td>
<td>9</td>
<td>4</td>
</tr>
<tr>
<td>Console Button or External Input</td>
<td>{JOY10}*</td>
<td>5</td>
</tr>
</tbody>
</table>

*Keyboard device ignores {JOY10}*

### Default Mappings, Celeritas Device Properties:

<table>
<thead>
<tr>
<th>Joystick Button</th>
<th>Secondary Joystick</th>
<th>Primary Joystick</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top Left</td>
<td>Joy6</td>
<td>Joy1</td>
</tr>
<tr>
<td>Top Right</td>
<td>Joy7</td>
<td>Joy2</td>
</tr>
<tr>
<td>Back Top</td>
<td>Joy8</td>
<td>Joy3</td>
</tr>
<tr>
<td>Back Bottom</td>
<td>Joy9</td>
<td>Joy4</td>
</tr>
</tbody>
</table>
Chapter 12: **Contact Information**

For additional information or support

[PSYCHOLOGY SOFTWARE TOOLS Logo]

Contact us at
Psychology Software Tools, Inc
311 23rd Street Extension, Suite 200
Sharpsburg, PA 15215-2821
Phone: 412-449-0078
Fax: 412-449-0079
www.pstnet.com

For Product Service and Support:
Please visit us at https://support.pstnet.com